## Revision History

Below are the development phases and dates of this **Prosthetics VistA Suite User Manual**.

<table>
<thead>
<tr>
<th>Section</th>
<th>Date</th>
<th>Patch</th>
<th>Page/Author</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPPD Detail Display User Manual</td>
<td>1/03</td>
<td>RMPR<em>3.0</em>71</td>
<td>Section 2 Page 65</td>
<td>New GUI feature</td>
</tr>
<tr>
<td>Automated Delayed Order Report</td>
<td>6/03</td>
<td>RMPR<em>3.0</em>59</td>
<td>Section 3 Page 83</td>
<td>New GUI feature</td>
</tr>
<tr>
<td>View Prosthetic Billing Information</td>
<td>1/05</td>
<td>RMPR<em>3.0</em>96</td>
<td>Section 4 Page 111</td>
<td>New GUI feature</td>
</tr>
<tr>
<td>Purchase Card Purchasing</td>
<td>4/05</td>
<td>RMPR<em>3.0</em>90</td>
<td>Section 1 Page 2</td>
<td>New GUI feature</td>
</tr>
<tr>
<td>NPPD Detail Display User Manual</td>
<td>4/05</td>
<td>RMPR<em>3.0</em>109</td>
<td>Section 2 Page 69</td>
<td>Added a new “Display Custom Data field” feature</td>
</tr>
<tr>
<td>Throughout</td>
<td>9/1/05</td>
<td>RMPR<em>3.0</em>90</td>
<td>Al Bustamante</td>
<td>Minor fixes per EVS</td>
</tr>
<tr>
<td>Section 5: Creating a Lab Work Order</td>
<td>2/22/06</td>
<td>RMPR<em>3.0</em>75</td>
<td>Al Bustamante</td>
<td>Added OWL creation section</td>
</tr>
<tr>
<td>Section 6: Orthotic Lab &amp; Work Order</td>
<td>8/11/06</td>
<td>RMPR<em>3.0</em>75</td>
<td>Al Bustamante</td>
<td>Added OWL Lab section</td>
</tr>
<tr>
<td>Sections 5 &amp; 6</td>
<td>3/2007</td>
<td>RMPR<em>3.0</em>75</td>
<td>Al Bustamante</td>
<td>Fixes per EVS and release of patch 75</td>
</tr>
<tr>
<td>Sections 5 &amp; 6</td>
<td>4/2007</td>
<td>RMPR<em>3.0</em>75</td>
<td>Al Bustamante</td>
<td>Fixes per EVS</td>
</tr>
<tr>
<td>RMPR<em>3.0</em>75 released</td>
<td>5/2007</td>
<td>RMPR<em>3.0</em>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RMPR<em>3.0</em>136</td>
<td>11/2007</td>
<td>RMPR<em>3.0</em>136</td>
<td>Al Bustamante</td>
<td>Updated GUI for Excel report save</td>
</tr>
</tbody>
</table>
# Table of Contents

Introduction to Prosthetics Application Suite User Manual................................................. 1
  User Manual Overview........................................................................................................ 1
Section 1 .............................................................................................................................. 3
GUI Purchase Card Purchasing.............................................................................................. 3
  Overview............................................................................................................................ 3
Chapter 1 – Roll and Scroll Features.................................................................................... 7
  Patch RMPr*3*90 Overview................................................................................................. 7
  Utilities Menu – Site Parameters File ................................................................................. 8
  Utilities Menu – Display Prosthetic PO Information (WD) ............................................... 11
  Purchasing Menu – Enter Waiver or Excluded Notice (EW) ............................................ 12
  Purchasing Menu – Enter/Edit Contract # (EC)................................................................. 14
Display/Print Patient 2319 (23) – Excluded and Waiver..................................................... 15
Chapter 2 – Access/Sign-on Instructions to GUI................................................................. 17
  Sign-On Properties (Optional)............................................................................................ 23
Chapter 3 – Purchase Ordering............................................................................................ 27
  The Purchase Order Control Window............................................................................... 27
  Select a Site and Status....................................................................................................... 28
  Select an SSN Range .......................................................................................................... 29
  Change Data Display ........................................................................................................ 31
  View Column Descriptions............................................................................................... 32
Chapter 4- Display the 2319............................................................................................ 33
  2319 Button....................................................................................................................... 33
  View 2319 – Patient Demographics (Tab 1)..................................................................... 35
  View 2319 – Clinic Enrollments/Correspondence (Tab 2)............................................... 36
  View 2319 – Entitlement Info (Tab 3)............................................................................... 37
  View 2319 – Appliance Transactions (Tab 4)................................................................. 38
  View 2319 – Auto Adaptive Info (Tab 5).......................................................................... 40
  View 2319 – Critical Comments (Tab 6)......................................................................... 41
  View 2319 – HISA Information (Tab 7)......................................................................... 42
  View 2319 – Home Oxygen (Tab 8).............................................................................. 44
Chapter 5 - View a CPRS Record....................................................................................... 47
  CPRS Button..................................................................................................................... 47
Chapter 6 - View a Request.............................................................................................. 49
  Request Button................................................................................................................ 49
Chapter 7 - Purchase Order Creation.................................................................................. 51
  Create a P.O. ..................................................................................................................... 51
  Select a Due Date.............................................................................................................. 54
  Select a Site...................................................................................................................... 56
  Select a Purchase Card................................................................................................. 57
  Cost Center......................................................................................................................... 58
  Select a Vendor............................................................................................................... 59
  Select the Delivery Method............................................................................................ 61
Chapter 8 - Add Item(s) to the Purchase Order................................................................. 63
Exiting the DOR Window .......................................................... 142
Section 4 .................................................................................... 145
View Prosthetics Billing Information ........................................... 145
Overview .................................................................................. 145
Chapter 1 - For Billing Users ...................................................... 147
Billing Main Menu Window ...................................................... 147
Chapter 2 – For Prosthetics Users ............................................... 149
Prosthetics Main Menu Window ................................................. 149
Chapter 3 – View Billing Information Package ................................ 151
View Billing Information Window .............................................. 151
Enter a Date Range .................................................................. 152
Display the Prosthetics Data ...................................................... 154
Change Data Display ................................................................ 155
View Column Descriptions - Site, Dates and Patient Data ......... 156
View Column Description - Insurance Information ................. 157
View Column Descriptions - Coding Errors ......................... 158
View Column Descriptions - Item Information ...................... 159
View Column Descriptions - Quantity and Total Cost Data ...... 160
View Column Descriptions - HCPCS and HCPCS Description Data 161
View Column Descriptions - ICD9 and ICD9 Description .......... 162
View Column Descriptions - Disability Information .............. 163
Chapter 4 - Printing ................................................................. 165
Print the View Prosthetics Billing Information Window ............ 165
Chapter 5 – Saving ................................................................. 167
Save as an Excel File ............................................................... 167
AutoFilter ................................................................................ 170
Chapter 6 - Closing and Exiting ................................................. 171
Exiting the View Prosthetic Billing Information Window .......... 171
Section 5 .................................................................................. 173
Creating a Lab Work Order ....................................................... 173
Overview .................................................................................. 173
Selecting a Lab Type ............................................................... 175
Selecting Stations ................................................................... 176
Patient Category and Type of Transaction ......................... 177
Primary Item Information ...................................................... 178
Changing the Date Required .................................................. 180
Changing the Print Location .................................................. 181
Viewing Additional Information .......................................... 184
Submitting the Lab Work Order .............................................. 185
Section 6 .................................................................................. 187
Orthotic Lab & Work Order ...................................................... 187
Overview .................................................................................. 187
Orthotic Lab & Work Order Window Areas ............................ 189
Title Bar .................................................................................. 189
Menu Bar ............................................................................... 190
Work Orders Listview ............................................................ 192
Introduction to Prosthetics Application Suite User Manual

User Manual Overview

Introduction
This Prosthetics Application Suite User Manual encompasses past GUI (graphical user interface) patches that provided new and enhanced GUI features for Prosthetics. This user manual will be the main user manual for all future GUI updates.

In this manual
This user manual contains the following topics and their corresponding sections:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Card Purchasing</td>
<td>Section 1</td>
</tr>
<tr>
<td>NPPD Detail Display</td>
<td>Section 2</td>
</tr>
<tr>
<td>Delayed Order Report</td>
<td>Section 3</td>
</tr>
<tr>
<td>View Billing Information</td>
<td>Section 4</td>
</tr>
<tr>
<td>Creating a Lab Work Order (OWL)</td>
<td>Section 5</td>
</tr>
<tr>
<td>Orthotic Lab &amp; Work Order</td>
<td>Section 6</td>
</tr>
</tbody>
</table>
Section 1
GUI Purchase Card Purchasing

Overview

Introduction to GUI Purchasing

Patch RMPR*3*90 is a large Prosthetics patch affecting the Purchase Card Purchasing features. There is a whole new module using GUI (graphical user interface) windows features to create a Purchase Card purchase order. You will no longer be able to use the roll and scroll Purchase Card Menu option.

IMPORTANT: A new feature in GUI Purchasing is that a purchase order cannot be created if the consult (or manual entry in Suspense) is not in an Open or Pending status.

Note: Reconciling a 1358 purchase order continues as a roll and scroll selection.

PSAS Menu options

There are several PSAS Menu options addressed with Patch 90. Here are the current roll and scroll VistA Prosthetics menu options that have been enhanced:

- Purchasing – Purchase Cards Menu Option
- Utilities Menu – Site Parameters option
- Display/Print Menu – Display/Print Patient 2319 (23) option (Appliance Transactions – Screen 4)

Three new roll and scroll menu options include:

- Purchasing Menu – Enter Waiver or Excluded Notice (EW)
- Purchasing Menu – Enter Contract Number (EC)
- Utilities Menu – Display Pros PO Information (WD)

Transaction Type

In this GUI Purchase Card Purchasing module with Patch RMRR*3*90, there are no longer four Transaction Types as they have been consolidated into two Types: The four Types were: S – Spare, X – Repair, I – Initial Issue, and R – Replace. This change has consolidated many steps into fewer keystrokes for users.

The two (2) consolidated Transaction Types are:

- I – New/Replace
- X – Service/Repair

Note: The Inventory, Home Oxygen and Lab modules still have four (4) Transaction Types.

Continued on next page
**Overview, Continued**

<table>
<thead>
<tr>
<th>SC and NSC Patient Categories</th>
<th>Also, there used to be four Patient Category options, and this has been consolidated into two options with this patch. The four options were:</th>
</tr>
</thead>
</table>
|                               | 1) Service Connected/In-Patient  
|                               | 2) Service Connected/Outpatient  
|                               | 3) Non-Service Connected/In-patient  
|                               | 4) Non-Service Connected/Outpatient  |

**The two NEW Patient Categories are:**

| 1) Service Connected  
| 2) Non-Service Connected |

**Note:** With this consolidation, there is no need for a Special Category which had four options for you to choose when you selected the Patient Category of Non-Service Connected/Outpatient option.

<table>
<thead>
<tr>
<th>Printed Purchase Order</th>
<th>The full social security number is not displayed on the printed purchase order; only the last four numbers on Form 2421. The purchase order number now appears on the top of this form. Also, the Lot number, Serial number, Make and Model appear on the purchase order (as appropriate).</th>
</tr>
</thead>
</table>
The Purchase Order Control window shown below displays consults from the Suspense module that have been entered through CPRS or entered manually. Open and Pending consults display here for one site or “All Sites” as well as a Purchasing Agent’s responsible SSN range for patients.
# Chapter 1 – Roll and Scroll Features

## Patch RMPR*3*90 Overview

### New and deleted features

There are new Roll and Scroll features with Patch RMPR*3*96 as well as updated features and features no longer needed.

### Purchasing Menu - Purchase Cards

The Purchase Cards option (under the Purchasing Menu (PU) and the Enter New Request (EN) option) are no longer needed in roll and scroll and cannot be used any longer.

The new GUI Purchase Order process is outlined in this user manual and has been developed to replace the roll and scroll process. There have been many features added within this process as well.

### Purchasing Menu

The new menu options in the Purchasing Menu include:

- **Enter Waiver or Excluded Notice (EW)**
- **Enter/Edit Contract Number (EC)**

### Utilities Menu

The Site Parameters file has been updated in the Utilities Menu with several new features and prompts. The enhanced option is the Enter/Edit Site Parameters (SP) option. You will then select the Enter/Edit Station Site Parameters (SS) option.

Also there is a new menu option, Display Pros PO Information (WD) for display purposes only.

### Display/Print 2319

There are two new display fields on the Display/Print Patient 2319 (in the Appliance Transaction – Screen 4) as follows:

- **Contract Number**
- **Excluded Waiver**
Utilities Menu – Site Parameters File

Site Parameters file

You must first set up the Site Parameters file to set up your Purchasing Agent information including their name and SSN range of responsibilities before they can begin to use the GUI Purchase Order feature. This is also where the Common Numbering Series (number that is created for the PO process) and the new Manager Comment is updated.

To access this file, select the Utilities Menu (UT) and the Enter/Edit Site Parameters (SP) option.

Note: This file can be updated when a Purchasing Agent is on vacation, sick or for any temporary purposes to transfer the SSN range of responsibilities to another Purchasing Agent.

Prosthetic Official’s Menu

PU Purchasing ...
DD Display/Print ...
UT Utilities ...
AM AMIS ...
SU Suspense ...
CO Correspondence ...
SC Scheduled Meetings and Home/Liaison Visits ...
PS Process Form 2529-3 ...
EL Eligibility Inquiry
ET PSC/Entitlement Records ...
HO Home Oxygen Main Menu ...
INV Pros Inventory Main ...
ND NPPD Tools ...
OC CoreFLS Order Control
VR VERIFY/REPAIR PURCHASE CARD NUMBER

Select Prosthetic Official's Menu Option: UT Utilities

Utilities Menu

AP Add/Edit Patient to Prosthetics
DIS Enter Prosthetic Disability Code to 2319
REM Delete Prosthetic Disability Code from 2319
EN Enter/Edit Prosthetic Item Master
IF IFCAP Utilities ...
PGE Purge Obsolete Data ...
RC Flag Item as Returned/Condemned
RE Edit Returned/Condemned Item
SP Enter/Edit Site Parameters ...
WD Display Prosthetic PO Information

Select Utilities Option: SP <Enter> Enter/Edit Site Parameters

Continued on next page
Utilities Menu – Site Parameters File, Continued

Next step

Select the **Enter/Edit Station Site Parameters (SS)** option as shown below.

<table>
<thead>
<tr>
<th>SS</th>
<th>Enter/Edit Station Site Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF</td>
<td>Set CPT Modifier Rental Flag</td>
</tr>
</tbody>
</table>

Select Enter/Edit Site Parameters Option: **SS <Enter>**

Enter/Edit Station Site Parameters

Select PROSTHETICS SITE PARAMETER SITE NAME:

- ATLANTA VAMC 508
- CORKWELL VAMC 500
- HINESTEST 999
- Hines Development System2 ST. NUM. 578
- SAN ANTONIO VAMC 671
- ZZOJ VAMC VAMC 991

Answer with INSTITUTION NAME, or STATUS, or STATION NUMBER, or OFFICIAL VA NAME, or CURRENT LOCATION, or CODING SYSTEM/ID PAIR, or NAME (CHANGED FROM), or CODING SYSTEM

Do you want the entire INSTITUTION List? **Y <Enter>** (Yes)

Choose from:
- ALBANY, NY 500
- ALBUQUERQUE, NM 501
- ALBUQUERQUE-RO NM 340
- ALEXANDRIA, LA 502
- ALLEN PARK, MI MI 553
- ALTOONA, PA 503

Select PROSTHETICS SITE PARAMETER SITE NAME: **500 <Enter>**

Printer

You also need to know the name of your printer to set it up in the Site Parameters file. This must be defined and cannot be entered as “null” as it must be a Prosthetic printer.

Continued on next page
Utilities Menu – Site Parameters File, Continued

Notice the new Manager Comment prompt below. You can enter a free-text comment that will display on the GUI Purchase Order Control window at the bottom of the display. This can be used by Supervisors to make announcements or specific messages to their responsible groups.

Site Parameters file

VAMC 500 COR
KWELL VAMC
SITE NAME: CORKWELL VAMC/
VISN: 17/
PHONE NUMBER: 
STREET ADD1: //
CITY: SAN ANTONIO/
STATE: TEXAS/
ZIP CODE: 78249/
MANAGER COMMENT: "Please enter your time today." <Enter>
CHIEF SIG BLOCK: PROSmanager,one,ACTING CHIEF,PROSTHETICS SERVICE
Replace Y <Enter> ?? Replace
Select PURCHASING AGENT: PROSpurchagent,one //
PURCHASING AGENT: PROSpurchagent,one//
START RANGE: 0//
STOP RANGE: 99//
With Patch RMPR*3*90, you can display purchase order information with the new option from the Utilities Menu called Display Prosthetic PO Information (WD). This will display purchase order information that does not contain patient name or sensitive information.

With Patch RMPR*3*90, you can display purchase order information with the new option from the Utilities Menu called Display Prosthetic PO Information (WD).

PU     Purchasing ...
DD     Display/Print ...
UT     Utilities ...
AM     AMIS ...
SU     Suspense ...
CO     Correspondence ...
SC     Scheduled Meetings and Home/Liaison Visits ...
PS     Process Form 2529-3 ...
EL     Eligibility Inquiry
ET     PSC/Entitlement Records ...
HO     Home Oxygen Main Menu ...
INV    Pros Inventory Main ...
ND     NPPD Tools ...
VR     VERIFY/REPAIR PURCHASE CARD NUMBER

Select Prosthetic Official's Menu Option: UT <Enter> Utilities

AP     Add/Edit Patient to Prosthetics
DIS    Enter Prosthetic Disability Code to 2319
REM    Delete Prosthetic Disability Code from 2319
EN     Enter/Edit Prosthetic Item Master
IF     IFCAP Utilities ...
PGE    Purge Obsolete Data ...
RC     Flag Item as Returned/Condemned
RE     Edit Returned/Condemned Item
SP     Enter/Edit Site Parameters ...
WD     Display Prosthetic PO Information

Select Utilities Option: WD <Enter> Display Prosthetic PO Information

Select PROSTHETICS 1358 DATE: 2-15-2005 EYEGLASSES-PRES

DEVICE: <Enter> INCOMING TELNET Right Margin: 80// <Enter>
Prosthetics Display MAR 10,2005 09:18 PAGE 1
------------------------------------------------------------------------------
Deliver To: OTHER LOCATION AT THIS SITE IFCAP Order: 516-0U7820
Vendor: INVACARE
Initiator: PROSDEVELOPER,ONE
Station Name: BAY PINES VAMC
Item: EYEGLASSES-PRESCRIPTION
Brief Description: EYEGLASSES
Unit Cost: 25.00 Qty: 1 Unit of Issue: EA Eyeglasses, Prescription
Select PROSTHETICS 1358 DATE:
Purchasing Menu – Enter Waiver or Excluded Notice (EW)

Definitions

The Enter Waiver or Excluded Notice (EW) option is from the Purchasing (PU) Menu. You can use this menu option if you forget to enter this information during the creation of the purchase order.

A Waiver is a device/vendor that is not on a National Prosthetics Mandatory BPA/Contract and is prescribed because it meets the needs of an individual patient. (The prescribing physician requests in writing to the Chief of Staff and if approved, a copy is forwarded to the VPR.) Excluded means that an Item (HCPCS) issued is not covered by a National Prosthetics Mandatory BPA/Contract.

Prosthetic Official's Menu

PU     Purchasing ...
DD     Display/Print ...
UT     Utilities ...
AM     AMIS ...
SU     Suspense ...
CO     Correspondence ...
SC     Scheduled Meetings and Home/Liaison Visits ...
FS     Process Form 2529-3 ...
EL     Eligibility Inquiry
ET     PSC/Entitlement Records ...
HO     Home Oxygen Main Menu ...
INV    Pros Inventory Main ...
ND     NPPD Tools ...
VR     VERIFY/REPAIR PURCHASE CARD NUMBER

Select Prosthetic Official's Menu Option: PU <Enter> Purchasing

Purchasing Menu

EN     Enter New Request ...
SI     Stock Issues ...
RP     Reprints ...
RE     Record 2237 Purchase to 2319
ED     Edit/Delete 2237 from 10-2319
EC     Enter Contract # and FPDS
CA     Cancel a Transaction
CO     Close Out
CPC    Cancel Purchase Card Transaction
CPO    Reconcile/Close Out Purchase Card Transaction
ED2    Edit 2319
EDPC   Edit Purchase Card Transaction
ER     Enter Product Information for Recall
EW     Enter Waiver or Excluded Notice
HI     Add Historical Data
HID    Delete Historical Data Entry
LI     List Open 1358 Prosthetic Transactions
LII    List Open 1358 Transactions By Initiator
LPC    List Open Purchase Card Transactions
LPCI   List Open Purchase Card Transactions By Initiator
LPS    Purchase Card Summary Sheet

Select Purchasing Option: EW <Enter> Enter Waiver or Excluded Notice

Continued on next page
The Waiver or Excluded information appears on the 2319.

**Note:** This new feature works for any Inventory/Stock Issues items as well.

---

**Enter Waiver or Excluded Notice**

```
Enter Patient Name or PO Number    1-27-2005 ITEM DES
...OK? Yes//<Enter>(Yes)

Patient Name: PROSpatient,one  <Enter>
Form: VISA
Transaction #: 0U7748
Brief Desc: ITEM DES
PSAS HCPCS: E2100
Item: WHEELCHAIR-H2000-18IN-ELEV
Vendor: SUN BRAND
Initiator: PROSdeveloper,one

EXCLUDE/WAIVER: ? <Enter>
    Choose from:
    E    EXCLUDED
    W    WAIVER
EXCLUDE/WAIVER: E <Enter> EXCLUDED

Enter Patient Name or PO Number    <Enter>
```
The Enter/Edit Contract Number (EC) option allows you to enter a new Contract number on the 2319 or edit an existing one. This menu option is a free-text field and you can enter any free-text.

Note: The Contract # has a maximum of 30 characters allowed in this prompt.
Display/Print Patient 2319 (23) – Excluded and Waiver

**Excluded and Waiver prompts**

With Patch RMPR*3*90, there are two new prompts on the 2319: Excluded and Waiver. You can display and print the 2319 from the Display/Print (DD) Menu (accessed from the Prosthetics Official's Menu) to update the Excluded or Waiver prompts on the 2319. Follow the sequence of prompts below to display or print the 2319.

**Display/Print Patient 2319**

Select Display/Print Option: 23 <Enter>  Display/Print Patient 2319
SITE: DVAMC BAY PINES 516/121// <Enter>  516
Select PROSTHETIC PATIENT: PROSpatient,one <Enter>  5-28-25 000277955 NO NSC VETERAN B B PC
NORTH PINELLAS
Enrollment Priority: GROUP 8c Category: IN PROCESS End Date: BAY PINES VAMC
DEVICE: HOME/<Enter> INCOMING TELNET Right Margin: 80// <Enter>
Current Disability Codes are:
AO/DIS OTHERS ELIG NSC PL-104-262 (ELIG. REFORM
AO/ELAS OTHERS ELIG NSC PL-104-262 (ELIG. REFORM

**Appliance Transactions (Screen 4)**

Select one of the following:

1. PATIENT DEMOGRAPHICS
2. CLINIC ENROLLMENTS/CORRESPONDENCE
3. ENTITLEMENT INFORMATION
4. APPLIANCE TRANSACTIONS
5. AUTO ADAPTIVE INFORMATION
6. CRITICAL COMMENTS
7. ADD/EDIT DISABILITY CODE
8. HOME OXYGEN ITEMS

Enter 10-2319 screen to VIEW (1-8),'' to EXIT, or 'return' to continue : 4 <Enter> APPLIANCE TRANSACTIONS

*Continued on next page*
Display/Print Patient 2319 (23) – Excluded and Waiver,
Continued

New Display fields

Below you can see the two new display fields on the Display/Print Patient 2319:

- Contract Number
- Excluded Waiver

Appliance/Repair Record for a Veteran

New display fields here:
Chapter 2 – Access/Sign-on Instructions to GUI

Open the Prosthetics Main Menu

Introduction

Introducing the Prosthetics Main Menu window, as shown below. This feature was first included in Patch RMPR*3*90. It will grow as more features are developed in the GUI suite of Prosthetics programs as part of an entire VistA suite of Prosthetics programs. It will remain the main point of access for future Prosthetics applications. This window allows you to access the current GUI features including the following:

- VistA Sign-On
- Processing (formerly Purchasing)
- View Prosthetic Billing Information
- Delayed Order Report
- NPPD Detail Display Report
- Orthotic Lab & Work Order (OWL)
- Help
- About (provides the version number of the application)
Display/Print Patient 2319 (23) – Excluded and Waiver, 
Continued

**Steps**

To sign on to VistA and access the Prosthetics applications, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | For Prosthetics users: Double-click the **Prosthetics Vista Suite** which is the medicine bag icon on your desktop.  
(For Billing Users: Double-click the **Prosthetics View Billing Menu** which is the green dollar sign icon on your desktop.) |
| 2    | Click the **VISTA Sign-On** button.  
**Shortcut:** Press the `<Alt>` key + `<S>` key.  
A confirmation window displays to alert you that opening this application may expose you to individually-identifiable information which must be kept confidential. |
| 3    | Click **Yes** if you agree to follow appropriate security and privacy policies. The **Connect To** dialog displays. |

**Confirm window**

The following displayed information may contain individually-identifiable information related to vendors, patients, or employees requiring appropriate measures be taken to secure the information and ensure the confidentiality of the information is maintained.

I understand that when viewing, printing or saving this information appropriate security and privacy policies should be followed.

[Yes] [No]

**Help and About Buttons**

If you require online help, you can click the **Help** button WITHOUT signing on.  
You can also access the **About** option WITHOUT signing on.
About window
(Version number may be different)

The Prosthetics Main Menu window is a location for a single sign-on to all the Prosthetics GUI applications. Using this main menu requires you to sign-on using the VISTA Sign-on button. Then you can decide if you want the Purchasing option, the View Prosthetic Billing Information option, the Delayed Order Report option, or the NPPD Detail Display Report option (until future applications are available).

Title Bar

After you sign on, all Prosthetics programs will display the server information that you are logged into in the Title bar of the application window.

Multiple Windows Open

After you log on, you can access multiple applications, and you can switch between open applications without having to relog on and without losing displayed data. If you change servers that you are logged into, then you will lose the data displayed in all open windows.

Exit the VistA Suite

You can logoff the Prosthetics Main Menu window by clicking the Close button. This exits you out of the VistA suite of Prosthetics applications. If you have any open Prosthetics applications when you exit, you will lose data in these open applications. A confirmation message will display as shown below.
Connect to the System (Only necessary for multiple sites)

Prosthetics Main Menu window

After you click the VISTA Sign-on button and click Yes at the Confirm window (as described above), the Connect To dialog box displays as shown below ONLY if you are connected to multiple sites/systems.

Workstations are typically configured to sign-on to a single system. However, if your workstation is configured to sign-on to more than one system (see example below), you will see the Connect To window whenever you try to establish a connection.

Connect To window

Steps To continue to access the VistA system, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the drop-down arrow in the Connect To dialog box to display the list of systems or press &lt;Enter&gt; for the default system (displayed).</td>
</tr>
<tr>
<td>2</td>
<td>In that list, click the connection you need.</td>
</tr>
<tr>
<td>3</td>
<td>Then click OK or press &lt;Enter&gt; to sign-on to that system.</td>
</tr>
</tbody>
</table>

Cancel Button You can click the Cancel button to exit the Connect To dialog box. 
Shortcut: Press the <Alt> key + <C> key to cancel.

Help Button The Help button displays online help regarding the dialog box that is currently displayed. You can also press the <F1> key to display online help.
Sign-On to VistA

Introduction

The VISTA Sign-on window is the main sign-on window for all VistA GUI applications. It displays the current system introductory messages, and lets you sign on to the system using your Access and Verify codes.

Note: This is the first window if you have only one system to sign-on to; otherwise, see the previous page.

VISTA Sign-on

To continue to sign on to the VistA system, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Access Code box on the VISTA Sign-on window, enter your access code.</td>
</tr>
<tr>
<td>2</td>
<td>Press the &lt;Tab&gt; key to jump to the Verify Code box.</td>
</tr>
<tr>
<td>3</td>
<td>In the Verify Code box, enter your verify code.</td>
</tr>
<tr>
<td>4</td>
<td>Press &lt;Enter&gt; or click OK to sign on.</td>
</tr>
</tbody>
</table>

VistA Sign-on window

Time-saving Tip

Alternatively, in the access code box you can enter your access code, a semicolon, and your verify code all at once. Then press <Enter> or click OK to sign on.
Menu Button

Once you have accessed the DOR window, the NPPD Detail Display window, or the View Prosthetic Billing Information window, you can return to the Prosthetics Main Menu by clicking the Menu button.

Multiple Windows Open

After you log on, you can access multiple applications, and you can switch between open applications without having to re-log on and without losing displayed data.

You can keep a window open (any Prosthetics GUI application) by clicking the Menu button, returning to the Prosthetics Main Menu window and opening another application. Once you have multiple programs open, you can switch back and forth between them and not lose any data.

Warning: If you change servers that you are logged into, then you will lose the data displayed in all open windows.

Logging Off

Log Off

You can also sign off the Prosthetics VistA Suite screen by clicking the Close Menu. The following message displays for you to click OK to continue or Cancel to cancel the log off procedure.

Confirmation Message

Are you sure you want to EXIT the Prosthetics Application Suite?

OK Cancel
Sign-On Properties (Optional)

From the Sign-on window, you can also set Sign-on Properties as shown below.

**Recommendation:** Do not change the settings. Use this option only if necessary.

Steps

To set sign-on properties, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the VistA Sign-on window, click the icon at the top left corner (to the left of the window title name).</td>
</tr>
<tr>
<td>2</td>
<td>From the VistA Sign-on window menu, choose the Properties option.</td>
</tr>
<tr>
<td>3</td>
<td>Set any individual properties you want to change on the Sign-on Properties dialog box, and click OK to save those changes.</td>
</tr>
<tr>
<td>4</td>
<td>To return the properties to their default values, click the Defaults button, and then click OK to save that change.</td>
</tr>
</tbody>
</table>

Sign-on Properties window
Note

Sign-on properties that you save will be used for subsequent sign-ons using this workstation.

Continued on next page
Sign-On Properties (Optional), Continued

**Window Position**
Below are the window positions as they appear on your desktop.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center (default)</td>
<td>The window will always appear in the center of the screen.</td>
</tr>
<tr>
<td>Current</td>
<td>The current position of the window will be saved and used in the future.</td>
</tr>
<tr>
<td>Remember</td>
<td>Each time the window is used and closed, it will record its position and open in that same place the next time it is used.</td>
</tr>
</tbody>
</table>

**Window Size**
Below are the window sizes as they appear on your desktop.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (default)</td>
<td>The size of the window as it was designed. Typically, this is 500 pixels wide by 300 pixels high.</td>
</tr>
<tr>
<td>Current</td>
<td>The current size of the window will be saved and used in the future.</td>
</tr>
<tr>
<td>Remember</td>
<td>Each time the window is used and closed, it will record its size and open with the same size the next time it is used.</td>
</tr>
</tbody>
</table>

**Color and Font**
Below are the text background colors and fonts.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>You can set the background color to Cream or White.</td>
</tr>
<tr>
<td>Font</td>
<td>You can choose any font on your system to use for the Introductory Text.</td>
</tr>
</tbody>
</table>
Chapter 3 – Purchase Ordering

The Purchase Order Control Window

**Display data**

The Purchase Order Control window shown below will display consults from the Suspense module that have been entered through CPRS or entered manually. Open and Pending consults display here for one site or “All Sites” as well as a Purchasing Agent’s responsible SSN range for patients.

To access the Purchase Order Control window, click the Processing button on the Main Menu.

**Purchase Order Control window**

![Purchase Order Control Window](image)

**Manager Notes**

The new feature, Manager Notes window, displays text-entered notes from a manager that can be displayed to all Purchasing Agents in their group.

**Create P.O.**

You will create a PO from this window for a specific patient.
Select a Site and Status

Site field
The first step to view purchasing transactions is to select a Site. There is a drop down list to select a specific site or you can select the All Sites checkbox (which is the default setting). The Site drop-down arrow may display a list of multiple sites for you to select one. When you click the drop down arrow, the checkmark from the All Sites checkbox disappears automatically.

**Recommendation:** It is strongly recommended that you always select All Sites so a consult does not get overlooked.

Purchase Order Control window

CBOC data
If you want to view all available suspense entries/electronic consult orders including Community Based Outpatient Clinics (CBOC) data, click the All Sites checkbox instead of selecting your specific site from the Site drop-down list box. This ensures that the display will include all sites. For example, the Kenosha, Wisconsin CBOC will not display when the Milwaukee site is selected only. These records display when the All Sites checkbox is selected.

Status options
The status selections are Open transactions and Pending transactions. They are both checked by default, but you can deselect one by clicking on it.
Select an SSN Range

This is a range of patient Social Security Numbers by the last two digits entered in the Starting SSN field and the Ending SSN field. When you enter a range, it will display electronic consults or manual suspense entries within that range.

A Purchasing Agent has two choices when entering SSN ranges:

1. Enter a specific SSN range within your responsible range by entering the Starting SSN and Ending SSN, or

2. Keep the “Or…your assigned SSN range” checkbox checked (which is the default setting).

The SSN range has been entered in the Site Parameters file by employee name. (See Chapter 1: Utilities Menu - Site Parameters File for more information.)

If your workload is categorized by the SSN for a specific Purchasing Agent, then you can display entries that are assigned by one Purchasing Agent at a time.

Note: Enter a range of 00 to 99 to view all Purchasing Agents’ SSNs for all patients.
Display button

Click the **Display/Refresh** button once you have selected a Site(s), Status and an SSN range. The transactions displayed depend upon what site was selected, whether you have selected **Open** or **Pending** or both statuses as well as the SSN range for the Purchasing Agent.

Data

The data that is displayed includes the following:

- Done
- Type (Routine, Eyeglass, Manual, Contact Lens and Clone)
- Station
- Date (Create date of Suspense entry)
- Days (Number of days the transaction has remained in Open or Pending status)
- Patient
- SSN
- Description (of the transaction)
- Status (Open or Pending)
- IEN 668
- Pt IEN

Purchase Order Control list

The last two digits of the... Starting SSN... Ending SSN... Display / Refresh

<table>
<thead>
<tr>
<th>Done</th>
<th>Type</th>
<th>Station</th>
<th>Date</th>
<th>Days</th>
<th>Patient</th>
<th>SSN</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
<tr>
<td>LAB</td>
<td>605</td>
<td>1/25/2003</td>
<td>4</td>
<td>6555555555</td>
<td></td>
<td>666-09-1547</td>
<td></td>
<td>FINDING</td>
</tr>
</tbody>
</table>

**Prosthetics VistA Suite (GUI)**

User Manual

March 2005

30
## Change Data Display

### Sizing columns
Columns are sizable on this window, but not movable. To resize a column, you can place the cursor on the column header borderline until you can view the double-headed arrow. Then click and drag the column until it is the size you want.

### Column sorting
You can manipulate the layout of the view in the **Purchase Order Control** window for display purposes. The following can be done for column sorting features:

- To enlarge a column, click and drag a cell border.
- To sort on any column, click on the header to sort it in *ascending order*.
- If you click on the same column again, it will sort it in *descending order*.

### Refresh data
You can click the **Display/Refresh** button to update your window with any new transactions that may have been added into Suspense.

If you have changed the sort order, you can refresh your data by clicking the **Display/Refresh** button again.

**Note:** Refresh does not reset any column resizing that has been done.

### Clear button
You can use the **Clear** button to blank out the window and start over with new display criteria.

### Menu button
The **Menu** button returns you to the **Prosthetics Main Menu** window where you can open additional applications at the same time.

### 2319 button
You can display all eight tabs of 2319 data for a patient from this button.

### CPRS button
You can view a CPRS record for a patient from this button.

### Request button
You can view a Request (if information is available for that patient) from this button.
# View Column Descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Done</strong></td>
<td>The Done column displays a <strong>Yes</strong> after you have created a purchase order with one or more items on it.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The <strong>Type</strong> column displays one of the following record types for the Purchase Order transaction: Manual Suspense entry or Routine Consult (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders). Clone is also a type of record that may display.</td>
</tr>
<tr>
<td><strong>Station</strong></td>
<td>The Station column displays the Station Number of the selected Purchasing Agent.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>The <strong>Date</strong> column displays the date the consult was entered into Suspense or the manual entry was created in Suspense.</td>
</tr>
<tr>
<td><strong>Days</strong></td>
<td>The <strong>Days</strong> column displays the number of days the transaction has remained in Open or Pending status.</td>
</tr>
<tr>
<td><strong>Patient</strong></td>
<td>The <strong>Patient</strong> column contains the veteran’s name, last name first. All patient transactions for the requested date range appear for Non-Service Connected (NSC) veterans.</td>
</tr>
<tr>
<td><strong>SSN</strong></td>
<td>The <strong>SSN</strong> column displays the patient’s Social Security Number (SSN).</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The <strong>Description</strong> column displays the prescription that was entered on the consult or during the manual suspense entry.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>The status displays either <strong>Open</strong> or <strong>Pending</strong>. Records with an <strong>Open</strong> status are shown in blue. Pending status transactions are shown in red.</td>
</tr>
</tbody>
</table>
Chapter 4 - Display the 2319

2319 Button

You can click the 2319 button on the Purchase Order Control window to display the View 2319 window with the following eight tabs:

1. Patient Demographics
2. Clinic Enrollments/Correspondence
3. Entitlement Info (not available)
4. Appliance Transaction
5. Auto Adaptive Info (not available)
6. Critical Comments
7. HISA Information
8. Home Oxygen
Exit

To exit, click the Close button or the button in the top right-hand corner.
View 2319 – Patient Demographics (Tab 1)

Tab 1
You can view the Patient Demographics tab that includes a patient’s benefits, eligibility, next of kin, emergency contact info (if available), and disabilities.

Patient Demographics tab
You can view the patient demographics for the veteran.

This includes: Name (in red if deceased, with Date of Death listed above the Date of Birth and a blank age field), address, next of kin, emergency contact information, veteran benefits and eligibility (former Prisoner of War (highlighted in blue if “Yes”), Aid & Attendance, service connected, non-service connected, etc.).

Close button
To close this window and return to the main Purchase Order Control window, click the Close button.
View 2319 – Clinic Enrollments/Correspondence (Tab 2)

Tab 2
You can view the Clinic Enrollments/Correspondence tab that includes last movement actions, clinic enrollments, pending appointments, and letters on file.

Clinic Enrollments/Correspondence

Close button
To close this window and return to the main Purchase Order Control window, click the Close button.

Description
This second tab details clinic enrollments and correspondence for the veteran. This includes the following: the last movement actions (i.e., hospital admissions and discharges), clinic enrollments, pending appointments and correspondence letters.
View 2319 – Entitlement Info (Tab 3)

Tab 3
The Entitlement Info tab is not available in this version of the Prosthetics application. This tab details entitlement and loan information for the veteran. This includes the following: PSC Issue Card, clothing allowance, items on loan, and items returned.

Entitlement Info

Close button
To close this window and return to the main Purchase Order Control window, click the Close button.
View 2319 – Appliance Transactions (Tab 4)

Tab 4

The **Appliance Transactions** tab displays the following information:

- **Date** (this is the date of the PO)
- **Quantity**
- **HCPC Item**
- **Type**
- **Vendor**
- **Station**
- **Serial**
- **HCPC**
- **Total Cost**
- **IEN 660**

The total number of records found displays at the bottom.

You can click the **View Detail** button to display the **Appliance Transaction Detail** window, which includes Appliance Item detail, IFCAP vendor, costs, lab info, historical data, and an extended description. (See the next page for more info about this window.)

**Note:** Columns are resizable on this window (not movable).

---

**Appliance Transactions**

Continued on next page
When you select a record and click the View Detail button, the Appliance Transaction Detail window displays as shown below.

To close this window and return to the main Purchase Order Control window, click the Close button.
The **Auto Adaptive Info** tab is not available in this version of the Prosthetics application.

To close this window and return to the main **Purchase Order Control** window, click the **Close** button.
View 2319 – Critical Comments (Tab 6)

Tab 6
You can view comments in the Critical Comments tab as shown below.

Critical Comments window

Close button
Click the Close button to exit the Critical Comments window return to the main Purchase Order Control window.
Tab 7

On the **HISA Information** tab, if there is no data for a specific patient, it will state “NOTHING TO REPORT.”

This tab details the HISA (Home Improvement Structural Alteration) information including the date, quantity, HCPC item, type, vendor, station number, serial, HCPCS Code, total cost of the item ordered, and IEN 660.

Continued on next page
View 2319 – HISA Information (Tab 7), Continued

**View Detail**
When you select a record and click the **View Detail** button, the **Appliance Transaction Detail** window displays as shown below.

---

**Appliance Transaction Detail**

To close this window and return to the main **Purchase Order Control** window, click the **Close** button.
Tab 8

The **Home Oxygen** tab displays the following information:

- Date
- Quantity
- HCPC Item
- Type
- Vendor
- Station
- Serial
- HCPC
- Total Cost
- IEN 660

Home Oxygen

Continued on next page
View Detail

When you select a record and click the View Detail button, the **Appliance Transaction Detail** window displays as shown below.

### Appliance Transaction Detail

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliance Item</td>
<td><a href="#">BRITISH HANDGRIPS</a></td>
</tr>
<tr>
<td>Description</td>
<td><a href="#">BRITISH HANDGRIPS</a></td>
</tr>
<tr>
<td>HCP Code</td>
<td>READY</td>
</tr>
<tr>
<td>NCP Code</td>
<td>123456</td>
</tr>
<tr>
<td>ICD-9 Code</td>
<td>123456</td>
</tr>
<tr>
<td>Amount</td>
<td>$100.00</td>
</tr>
<tr>
<td>Source</td>
<td>COMMERCIAL</td>
</tr>
<tr>
<td>Order No.</td>
<td>P123456</td>
</tr>
<tr>
<td>Item No.</td>
<td>123456</td>
</tr>
<tr>
<td>Remarks</td>
<td><a href="#">BRITISH HANDGRIPS</a></td>
</tr>
<tr>
<td>IFCAP Vendor</td>
<td>OLYMPUS SERVICE CENTER</td>
</tr>
<tr>
<td>Address</td>
<td>2900 WOODWIND AVENUE</td>
</tr>
<tr>
<td>City</td>
<td>SAN JOSE</td>
</tr>
<tr>
<td>State</td>
<td>CALIFORNIA</td>
</tr>
<tr>
<td>ZIP</td>
<td>93956</td>
</tr>
<tr>
<td>Phone</td>
<td>123-4567</td>
</tr>
<tr>
<td>Remarks</td>
<td><a href="#">BRITISH HANDGRIPS</a></td>
</tr>
</tbody>
</table>

---

**Close button**

To close this window and return to the main **Purchase Order Control** window, click the **Close** button.
Chapter 5 - View a CPRS Record

CPRS Button

Click the CPRS button on the main Purchase Order Control window to display the View CPRS window if information is available.

CPRS Record

To exit the View CPRS window, click the Close button to return to the Purchase Order Control window.
Chapter 6 - View a Request

Request Button

Click the **Request** button on the main **Purchase Order Control** window to display the **View Request** window (if information is available) including a description of the item/services, Order/Suspense date, Initial Action and/or Completion date if applicable, and Initial Action or Completion note if available.

View Request window

To exit the **View Request** window, click the **Close** button to return to the **Purchase Order Control** window.
Chapter 7 - Purchase Order Creation

Create a P.O.

First step
Select a patient from the Purchase Order Control window. Check Eligibility for the patient on the 2319 Patient Demographics tab, and check to see if there are any duplicate orders on the 2319 Appliance Transactions tab. Then proceed to click the Create P.O. button.

Create P.O. button

The Purchase Order window displays a two-panel window as shown below. It contains the patient name and SSN in the title bar.

- The left-side panel is the Policy Panel. This panel has buttons that display pop-up windows for you to enter and display additional purchase order information.
- The right-side is the Purchase Order window. Its information fields display data as you complete the information in the Policy Panel pop-up windows.
Create a P.O., Continued

<table>
<thead>
<tr>
<th>CPRS and Request</th>
<th>You can also review the CPRS and the Request buttons for a patient before creating a PO to update yourself on the patient.</th>
</tr>
</thead>
<tbody>
<tr>
<td>More about the Policy Panel</td>
<td>You begin the PO process by clicking each button on the Policy Panel in order. If a button has green text, it is not required to click it (i.e., Due Date button and possibly the Site button) but you can click it to change the default data. If a button has red text, then it is a required button, and you must click it or you will not be able to proceed to the next button on the list in the Policy Panel. Note: The Site button already has a check in the checkbox in this example because a Site was selected before displaying transactions on the previous window. You can change the default Site by clicking the button. The Due Date does not have a checkbox and has a default setting of 30 days from the current date. You only need to check it if you want to change the Due Date setting. As you click each button on the Policy Panel and fill in information in the pop-up window that displays, the fields in the Purchase Order window will automatically populate with the data you entered in the corresponding pop-up window. Once you select a button on the Policy Panel, notice the checkbox in the Policy Panel next to a button is automatically checked. This tracks which buttons you have completed in the PO creation process.</td>
</tr>
<tr>
<td>Purchasing Order window fields</td>
<td>The fields within the Purchase Order window are populated in the order of the buttons on the Policy Panel. As you click each button, a pop-up window displays allowing you to enter data that will automatically fill in the fields on the Purchase Order window.</td>
</tr>
</tbody>
</table>
Select a Due Date

First Step on Policy Panel

Click the Due Date button on the Policy Panel if you want to change the default of 30 days from the current date. You do not need to click this button if you want to keep the 30 day default. If you click the Due Date button, a four-month calendar displays for you to select a due date.

Selecting a due date

The calendars display with the current date circled in red and the due date marked with a blue ellipse. You can accept the current date by clicking OK. You can also change the date by the following methods:

<table>
<thead>
<tr>
<th>Change the…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Click on the actual day of the week in the calendar. You must select the current date or a date in the future.</td>
</tr>
<tr>
<td>Month</td>
<td>Click on the month at the top of the calendar to display a list of all months and select one from there. You can decrease or increase one month at a time by clicking the left or right arrows.</td>
</tr>
<tr>
<td>Year</td>
<td>Click on the year and an up and down arrow button displays for you to increase or decrease the year.</td>
</tr>
</tbody>
</table>

Calendars

Please Select a New Due Date...

This selected Due Date is 30 days from today
Select a Site

Select a Site

Click the Site button on the Policy Panel. You can click the drop-down arrow to select a site. Click OK to display the data on the Purchase Order Control window. Notice that a green checkmark displays next to the Site button once you have selected an option.

Note: The number in the Common Numbering Series field comes from the Site Parameters file and automatically displays when you select a Site. You can now select a different numbering series, if that is how your site is organized.

Site

Site ID and Common Numbering Series fields

Checkmarks

Checkmarks display next to the buttons on the Policy Panel to track which steps you have completed in the PO creation process.

Add/Edit Patient option

If you select a patient that is not in the Prosthetics Patient File, a message displays to inform you that you are unable to continue. Click OK to clear the message. Please use the Add/Edit Patient (AP) option to add the patient to Prosthetics.

Add/Edit Patient (AP) option
Select a Purchase Card

Select a purchase card by clicking the Purchase Card button on the Policy Panel.

The Please Select a Purchase Card pop-up window displays. Click the dropdown arrow to display a list and select one.

To select a different Common Numbering Series, click the dropdown arrow.

Click Ok. The window disappears and the data displays in the Purchase Order Control window based on your selection for the Purchase Card number, Fund Control Point and Cost Center.

Note: Notice that a checkmark displays next to the Purchase Card button.

Select a Purchase Card

![Screenshot of the Please Select a Purchase Card window]

Cost Center button

The Cost Center is already populated for you when you select a Purchase Card.

Cost Center is not editable.

P Card Name / Cost Center / Fund Control Point

![Screenshot of the Purchase Order Control window]
## Cost Center

<table>
<thead>
<tr>
<th>Cost Center button</th>
<th>The Cost Center is already populated for you when you select a Site.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cost Center is not editable.</td>
</tr>
</tbody>
</table>
Select a Vendor

Vendor field
Click the Vendor button on the Policy Panel. Enter a partial spelling (minimum of three characters) of a Vendor and click the drop-down arrow to select one beginning with the criteria that you entered. Click OK to accept it. After the vendor is selected the following fields cannot be changed: Site, Purchase Card and Vendor.

Note: If you do not enter at least three characters of a vendor before you click the drop-down arrow, the list will be empty.

Warning Message: If you enter a partial spelling search that is not descriptive enough, a warning message dialog box will display.

Partial Spelling Search

Vendor list
**Vendor field**

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>INVITROGEN CORP</td>
</tr>
<tr>
<td>Phone</td>
<td>800/955-6288</td>
</tr>
<tr>
<td>Addr 1</td>
<td>1600 FARADAY AVE</td>
</tr>
<tr>
<td>Addr 2</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>CARLSBAD</td>
</tr>
<tr>
<td>State</td>
<td>CALIFORNIA</td>
</tr>
<tr>
<td>Zip</td>
<td>92008</td>
</tr>
<tr>
<td>Ship to</td>
<td></td>
</tr>
<tr>
<td>Attn</td>
<td></td>
</tr>
</tbody>
</table>
Select the Delivery Method

Delivery locations

Click the Delivery button on the Policy Panel. There are three delivery location options including: Prosthetics, Veteran, and an Other Location - At This Site option, which is a new option with Patch RMPR*3*90.

Note: If you choose the Other Location - At This Site option, another pop-up window displays as shown below.

Select a Delivery Location

Other Location

You can enter a free-text description in the blank field (with a maximum of 50 characters) on the Other Location – At This Site pop-up window which is a new feature with this patch. This helps warehouse employees to determine a delivery location.

Note: This information does not print on a hard copy printout.

Other Location

Next Step

Click OK to return to the Purchase Order Control window and select the next button on the Policy Panel.
Chapter 8 - Add Item(s) to the Purchase Order

Add Items Button

Purchase Order Items

When you click the Add Items button on the Policy Panel, the Purchase Order window displays as shown below. The Purchase Order number, patient’s name and SSN display at the top. This window provides multiple steps to add information when adding one or multiple items to the Purchase Order.

Add Items button

Continued on next page
Add Items Button, Continued

First Step

On the Purchase Order window, you MUST select a Type of Transaction as either New/Replace, Service/Repair or Rental Item.

Note: These three transactions types have been consolidated from four types with this patch.

Second Step

The Patient Category (SC or NSC) radio buttons are displayed. This is an enhanced feature with this patch that has been consolidated into two options. You MUST select either SC (Service Connected) or NSC (Non Service Connected).

Note: If there is a SC Disability, it will display in the box at the top. There is no longer any additional selection of eligibility for the Special Category.

Purchase Order window

Note: You can use the Tab key to tab from one field to the next on this window. You can also use the spacebar to check a checkbox.

Continued on next page
Add Items Button, Continued

**Billing Item**

You can select the **Billing Item** by entering partial spelling search criteria with a minimum of three characters. You MUST enter a partial spelling to begin your search. Once you type the initial search value, you can click on the drop-down arrow and a list will display. From this list, you can scroll to select an option.

**Note:** This billing information does not display on the 2319 nor does it print on the Purchase Order. It is only for billing purposes.

**Purchase Order window**

You MUST enter a partial spelling of the **HCPCS** Description (or HCPCS code or synonym) to begin your search. Once you type an initial search value, you can then click on the drop-down arrow and a list will display. From this list, you can scroll to select an option. If you know the code, you can enter the entire HCPCS code.

**Note:** The search criteria must be for a valid HCPCS code.

**HCPCS Criteria Search**

Click **Number of Bids** to enter a bid on this item. The maximum number of bids on an item is 3. For certain HCPCS (e.g., HISAS, HISAN), this window will automatically open for your selection. It should be used whenever you receive a bid for a prosthetic item.
Contract

You can select the **Contract** information by clicking the drop down arrow to begin your search. Once you type an initial search value, you can then click on the drop-down arrow and a list will display. From this list, you can scroll to select an option.

**Note:** The Contract information is tied to the Vendor in the **Vendor** file and will display according to the Vendor that was selected.

*Continued on next page*
Add Items Button, Continued

**Brief Description**
You can enter a Brief Description in the free-text field (with a maximum of 60 characters) which prints on the purchase order. You can also (optionally) add free-text Remarks. If you would like to enter an extended description, click the Extended Description button. See below for more information.

**Extended Description**
Notice as the Extended Description window shows below that you can type in a free-text extended description (of unlimited maximum number of characters). This information appears on the printed PO.

**Extended Description**

![Extended Description Window]

**Purchase Order**

![Purchase Order Window]

Continued on next page
Add Items Button, Continued

Remarks
You can enter free-text information up to a maximum of 30 characters in the Remarks field.

Extended and Waiver
There are two NEW prompts shown below. You can click the checkboxes if the item is considered excluded or has a waiver. (You can also use the spacebar to select one of the checkboxes after using the Tab key.)

If you forget to select the Excluded or Waiver checkboxes in the creation of the PO, you can go into the Roll and Scroll Enter Waiver or Excluded Notice (EW) option and enter the information afterwards.

Purchase Order

Optional fields
The following fields are optional:

- Manufacturer (with a maximum of 30 characters)
- Model (with a maximum of 30 characters)
- Serial # (with a maximum of 15 characters)
- Lot # (with a maximum of 30 characters)

This information prints on the Purchase Order.

Continued on next page
Add Items Button, Continued

**Unit of Issue**

You can select a Unit of Issue from a drop-down selection list. Enter a partial spelling search of one character minimum.

**Qty and Cost**

You can enter the Quantity and Unit Cost of the item you are adding to the Purchase Order. Notice that the Total Cost will be calculated automatically for you when you click in that field. You can also use the Tab key to view the Total Cost.

**Add Item to PO button – REQUIRED!!**

REQUIRED: Once you have entered all the correct information for the Item, you MUST click the Add Item to P.O. button. This button will appear double lined or highlighted to remind you to click it.

The information disappears from this Purchase Order window to allow you to add more items if necessary.

**WARNING:** If you click the Return to P.O. button before you click the Add Item to P.O. button, you will LOSE all the data that you have entered for that specific item.

---

### Purchase Order

![Purchase Order Window]

- **Billing Item:** WHEELCHAIR 22 INCHES
- **HCP/CIS:** 21605  WHEELCHAIR POWER ATTACHMENT
- **Contract:** 75379-3903K NOV 30, 2008 CONTRACT
- **Unit Desc:** WHEELCHAIR POWER ATTACHMENT
- **Remarks:** ISSUED
- **Included?**
- **Waiver?**
- **Manufacturer:** MYCARE
- **Model:** 49990
- **Serial #:**
- **Lot #:**

**Unit of Issue:** EACH

**Qty:**

**Unit Cost:** $27.06

**Total Cost:** $37.06

**Add Item to P.O.**

**Return to P.O.**
Return to P.O. Button

After you click the Add Item to P.O. button for all the items you want to add to this Purchase Order, then click the Return to P.O. button. The Purchase Order Control window displays where you can verify that the item(s) has been added to the Purchase Order.

Warning: Do NOT click the Return to P.O. button before the Add Item to P.O. button as the data will disappear and you will have to re-enter it.
Add Additional Items

**Item List**

Notice below the list with the item added in the display. It carries over the information that you selected from the Purchase Order window.

You can add more items by clicking the Add Items button as many times as necessary.

**Add Items button**

![Add Items button image]
Edit/Delete an Item

**Item List**
You can edit a line item or delete a line item by clicking on it and clicking the **Edit/Delete Item** button. You are returned to the **Purchase Order** window to make your edit or deletion.

**Edit/Delete Item**

Continued on next page
Edit/Delete an Item, Continued

Delete or Edit an Item

Once you have made edits to the Item that you are adding, click the Update Item button.

- OR -

Once you have verified the item you want to delete, click the Delete This Item button.

- THEN -

Click the Return to PO button. This will save the edits that you have made as well as the deletion.

Purchase Order window

Click the Update Item button to save your changes.

Click the Delete This Item button to delete the item.

Click the Return to P.O. button to go back to the previous screen.
Chapter 9 - Purchase Order Creation Continued

Enter Discount/Shipping

Discount/Shipping (Optional)

Click the Discount/Shipping button on the Policy Panel. Enter the Discount percentage for the item you are ordering and the Shipping amount (if applicable).

Click the OK button to add the Discount and the Shipping to the order.

Add Discount and Shipping Charge

Discount and Shipping amounts shown
Enter Your Electronic Signature

Print PO

The PO will print automatically once you submit the PO. The PO can print on both Windows printers and VistA printers. You can select a different printer by either clicking Windows Printer or selecting a VistA Printer from the dropdown list.

Signature

Click the Submit Order button on the Policy Panel. Enter your Electronic Signature and click the Send PO button.

Enter Your Electronic Signature

![Image of Print PO interface]

Complete order

Click the OK button on the Confirmation window as shown below. This window displays the current status of the PO as either Pending or Complete.

Confirmation Window

![Image of Confirm window]

Insufficient Funds

If your purchase card does not have adequate funds to cover the purchase order, you will get the message below. You can get more funds allocated to the purchase card and continue the process.
Insufficient Funds Window

**Insufficient Funds Window**

An error has occurred. Your VPCAP order may be canceled due to a lack of funds. If you can immediately get an increase of funds re-enter your e-sign and complete this PO. IF YOU LEAVE THIS SCREEN YOUR PO WILL BE LOST.

[OK]
Post CPRS Note

Close the order

Click the Post CPRS Note button on the Policy Panel when you have entered all the necessary information for the item you are ordering. The Post Note to CPRS pop-up window displays as shown below.

NOTE: By posting your note in this new method, you have automatically linked your transaction to the consult and created your patient care encounter. No further linking is necessary!

Post Note to CPRS

Post Complete

You have three checkboxes to choose a selection for your note-to-be: 1) Post Complete, 2) Post Initial and 3) Post Other. Last, click the Post Note button.

Click the Post Complete checkbox (if applicable), and enter a note in the free-text box area (optional) which has unlimited amount of space to enter a note. This checkbox places the transaction from a PENDING status to a CLOSED status.

Click the OK button to process the completion. Continue to the next page.

NOTE: When you select Post Complete an encounter is created.

Post Initial and Post Other

If you select the Post Initial checkbox, this places the transaction from an OPEN status to a PENDING status. The Post Other checkbox will put the transaction in a PENDING status if it is in an OPEN status or will keep it at PENDING if that is the current status.

Continued on next page
Post CPRS Note, Continued

**Complete order**
When you have completed the process to posting the CPRS note, you will receive the following two pop-up messages. If you selected the Post Complete checkbox, the first pop-up displays as shown with the Closed status for the suspense entry.

Click the **OK** button to finalize the order.

---

**Closed Suspense**

![Closed Suspense Pop-up Window](image)

**Post Initial**
When you click the Post Initial checkbox, the status of the suspense entry changes from Open to Pending status. The popup window will display as shown below.

---

**Post Initial Popup window**

![Post Initial Pop-up Window](image)

*Continued on next page*
Post CPRS Note, Continued

**Done column**

The **Purchase Order Control** window returns after you have completed the purchase order creation process. Notice that the **Done** column displays “Yes” in it.

The status of the transaction will be updated from Open to Pending or from Pending to Closed.

**WARNING:** If you click the **Refresh** Button, the **Done** column will refresh and the transactions that you have completed will disappear from the list as they now have a CLOSED status.

---

**Purchase Order Control window**
Chapter 10 - Closing and Exiting

Exit the Purchase Order Control Window

Exit the Application

You can exit the application by first clicking the **Menu** button on the **Purchase Order Control** window. Then click the **Close** button on the **Main Prosthetics** window: When the **Confirmation** window displays, click the **OK** button to exit.

Confirmation window

![Confirmation Window](image)

Are you sure you want to EXIT the Prosthetics Application Suite?

- [OK]
- [Cancel]

Cancel button

If you click the **Cancel** button, you will remain in the application and can continue to work.
**Sample Printout**

### Reprint PO

Below is a reprint of the PO number: **0U7820**.

### Purchase order reprint option

<table>
<thead>
<tr>
<th>Select Transaction or Patient Name:</th>
<th>0U7820</th>
<th>2-15-2005</th>
<th>PROSpatient, one Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>EYEGLASSES-PRES</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Would you like to print the Privacy Act Statement? Answer: Yes// (Yes)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Would you like to print a Patient Notification letter? Answer: No// (No)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEVICE: HOME// INCOMING TELNET</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Right Margin: 80// OMB Number 2900-0188</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PO#: 0U7820</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

***ORIGINAL COPY AND COMMERCIAL INVOICE MUST BE SUBMITTED***

TO THE VAMC PROSTHETIC ACTIVITY LISTED BELOW

<table>
<thead>
<tr>
<th>Department of Veterans Affairs</th>
<th>Prosthetic Authorization for Items or Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Name and Address of Vendor</td>
<td>2. Name and Address of VA Facility</td>
</tr>
<tr>
<td>INVACARE</td>
<td>DVAMC BAY PINES 516/121 (516/121)</td>
</tr>
<tr>
<td>899 CLEVELAND ST</td>
<td>PROSTHETIC &amp; SENSORY AIDS SERVICE</td>
</tr>
<tr>
<td>P O BOX 4028</td>
<td>BAY PINES, FL 33744</td>
</tr>
<tr>
<td>ELYRIA, OH 44036</td>
<td></td>
</tr>
<tr>
<td>800-642-8262</td>
<td>727-398-9345</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Veterans Name (Last, First, MI)</td>
<td>4. Date of Authorization</td>
</tr>
<tr>
<td>PROSpatient, one Y</td>
<td>FEB 15, 2005</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Veterans Address</td>
<td>6. Date Required</td>
</tr>
<tr>
<td>9 E ORANGE ST</td>
<td>MAR 17, 2005</td>
</tr>
<tr>
<td>SERIA LEONE, LOUISIANA 12345</td>
<td></td>
</tr>
<tr>
<td>304-288-3401</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9. Authority For Issuance CFR 17.115</td>
</tr>
<tr>
<td></td>
<td>CHARGE MEDICAL APPROPRIATION</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Claim Number SS</td>
<td>8. ID #: 4800 (Used to be full SSN.)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Statistical Data</td>
<td>11. FOB Point</td>
</tr>
<tr>
<td>SC/IP</td>
<td>ORIGIN</td>
</tr>
<tr>
<td></td>
<td>% 12</td>
</tr>
<tr>
<td></td>
<td>30 Days</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14. Delivery To: OTHER LOCATION AT THIS SITE</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>15. DESCRIPTION OF ITEMS OR SERVICES AUTHORIZED</td>
<td></td>
</tr>
<tr>
<td>ITEM NUMBER</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>#1. EYEGLASSES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial Number: 48DJ47DK39</td>
</tr>
<tr>
<td></td>
<td>Model: 2A</td>
</tr>
<tr>
<td>16. Contract Number: GS-00F-8355A(MAS)</td>
<td>Subtotal: 25.00</td>
</tr>
<tr>
<td>ACCT. #: 95150</td>
<td>Discount $ 3.00 Shipping: 24.00 Total $ 46.00</td>
</tr>
</tbody>
</table>
17. Signature of Requesting Official  
PROSUser,one

18. Date

19. Signature and Title of Contracting/Accountable Officer 
PROSUser,one

Order and Receipt Action

21. Order Number 4716360100064653

22. Exp Date

23. Date Item Received

24. Date Delivered

(Purchase Order Number and Expiration Date added.)

25. The articles or services listed herein have been received, or rendered ordered in the quantity and quality specified originally or as shown by authenticated changes, except as noted.

Signature of Veteran or VA Official

Acct. Symbol 516-0U7820

CONTINUATION OF PURCHASE CARD ORDER NUMBER: 0U7820

Department of Veterans Affairs|Prosthetic Authorization for Items or Services

1. Name and Address of Vendor

INVACARE
899 CLEVELAND ST
P O BOX 4028
ELYRIA, OH 44036
800-642-8262

2. Name and Address of VA Facility

DVAMC BAY PINES 516/121 (516/121)
PROSTHETIC & SENSORY AIDS SERVICE
BAY PINES, FL 33744
727-398-9345

3. Veterans Name (Last, First, MI)

LXYF, ZLUQDY A

4. Date of Authorization

FEB 15, 2005

15. DESCRIPTION OF ITEMS OR SERVICES AUTHORIZED

<table>
<thead>
<tr>
<th>ITEM NUMBER</th>
<th>DESCRIPTION</th>
<th>QUANTITY ORDERED</th>
<th>UNIT</th>
<th>UNIT PRICE</th>
<th>AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Eyeglasses, Prescription</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ADP Form 10-2421PC  APR 1991
Section 2
NPPD Detail Display

Overview

Introduction
This section covers the National Prosthetic Patient Database (NPPD) Detail Display feature.

Prosthetics users will be able to do the following with this patch:

• Search for data and display data by a range of dates.
• Sort and rearrange the view; display data in a custom view.
• Print the display.
• Convert the display into a Microsoft Excel file (for more complex sorting capabilities).

Data displayed
The data that is displayed on this window includes the following:

• Site
• Date (Suspense entry date)
• Type of transaction (I=Initial/New and X=Repair)
• Form type (Stock Issue, Purchase Card, 2237, Other)
• Patient name
• Social Security Number
• IEN
• Brief description
• HCPCS code and description
• NPPD code
• Initiator name
• Suspense Initial Action date
• Cost
• Quantity
• VA or Commercial
• Vendor name
• Grouper number (from AMIS)
Enter a Date Range

**Date/Calendars**  
After you have successfully signed on to VistA and the **NPPD Detail Display** window appears, you must select the date range that you want to view.

Enter a **Beginning Date** and an **Ending Date** by clicking on the drop-down list boxes next to the respective fields. A calendar displays as shown below.

You can also click the **File** menu and the **Select Beginning Date** or **Select Ending Date** option.

**Shortcut:** Press the **<Ctrl>** key + **<B>** key for the Beginning Date and the **<Ctrl>** key + **<E>** key for the Ending Date to display the respective calendars.

Calendar for date range selection

Continued on next page
Selecting a date range

The calendars display with the current date circled in red shown at the bottom of the calendar. You can accept the current date by clicking on it. You can also change the date by the following methods:

<table>
<thead>
<tr>
<th>Change the…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Click on the actual day of the week in the calendar.</td>
</tr>
<tr>
<td>Month</td>
<td>Click on the month at the top of the calendar to display a list of all months and select one from there. You can decrease or increase one month at a time by clicking the left or right arrows.</td>
</tr>
<tr>
<td>Year</td>
<td>Click on the year and an up and down arrow button displays for you to increase or decrease the year.</td>
</tr>
</tbody>
</table>

Number of Day Restrictions

You are restricted to a date range of less than 100 days. If you select a date range outside of this 100 day parameter, the following dialog message box displays:

Start Date before End Date

If you accidentally entered an incorrect date range, you will receive a warning message. For instance, if you enter a start date that is after the end date, the message below will display. Click the OK button and reselect your date range.

Start/End Date Message

The Starting Date must be before the Ending Date.

OK
Display the Data

Display the data

Once you have selected the date ranges, click the **Display** button to reveal the data within that date range. (You can also click the **File** Menu and the **Display** option.)

**Shortcut:** Press the `<Ctrl>` key + `<D>` key.

Changing the display of the data...

You can manipulate the layout of the view in the **NPPD Detail Display** window for both viewing as well as printing purposes.

You can manipulate the view of the data as follows:

- To move a column, click and drag on a column header to another location.
- To enlarge a column, click and drag a cell border.
- To sort on any column, click on the header to sort it in **ascending order**.
- If you click on the same column again, it will sort it in **descending order**.

**NPPD Detail Display**

![NPPD Detail Display](image)

**Patient confidentiality**

The **Patient** column and the **SSN** column have been shortened due to patient name and SSN confidentiality issues in documentation.
Select Custom Data

Custom Data

The **Select custom data?** drop-down lists allow you to select new columns to display. They also would convert into a Microsoft Excel file. These are optional prompts as you are not required to select any options. This is the main file for prosthetic purchasing transactions. This file is also the permanent record for the patient VAF 10-2319 of items issued to the veteran.

This list gives you the option to add information that was entered during the purchase order creation process to your NPPD Detail Report. For instance, if you added a Waiver or Excluded, you can view that data here.

**Note:** Custom data will display in the column to the right and you will have to scroll to the right to view it. If you do not see the new column, click the **Display** button.

MS Excel

If you selected custom data and convert it to an MS Excel file (using the **Excel** button), you will view the custom data on the Excel spreadsheet as you scroll to the right.

*Continued on next page*
Select Custom Data, Continued

**Data fields**
Below is a list of the Custom Data fields and a description of each.

01 **ENTRY DATE**
This is the date that the transaction was entered into the system. It may or may not be the same as the request date.

02 **PATIENT NAME**
This is the name of the patient that this transaction is for. The name is a pointer to the PROSTHETIC PATIENT file which has the same internal entry number as the main patient database.

1 **DATE ITEM ADDED TO PO AFTER CREATION**
This field is the date the appliance issue or repair was requested by the patient. It may or may not be the same as the entry date or the delivery date. This depends on how quickly the transactions take place.

2 **TYPE OF TRANSACTION**
This set of codes will tell what kind of transaction this request is. The possibilities all fall under the VAF 10-7306a listings except for the repair.

4 **ITEM**
This field is a pointer to the master item list of possible appliances. The master list is set up so that appliances fall into groups which are the types of appliances.

4.1 **HCPCS**
Health Care Financing Administration Common Procedure Coding System (HCPCS). This field should have the HCPCS code for the Item you are selecting. HCPCS is a uniform method for healthcare providers and medical suppliers to report professional services, procedures and supplies.

4.2 **VENDOR TRACKING NUMBER**
This field is the Vendor's internal unique tracking number. Some of the small vendors are not automated with VISA, and this tracking number is used to reference this transaction. This tracking number is based on the item, and can be as simple as the vendors item number, or elaborate as the vendors transaction number. This data will be used in the reconciliation process.

4.3 **BANK AUTHORIZATION NUMBER**
This six digit number is the authorization number VISA gives to the vendor for guaranteed payment. This number is used in the reconciliation process.

4.4 **ICD9 CODE**
Repository for CPRS diagnosis. From the message protocol in Consult Tracking. Standardized Prosthetics HCPCS.

4.6 **STOCK ISSUE**
This is a pointer to file #661.2.

*Continued on next page*
Select Custom Data, Continued

4.7 CPT MODIFIER
CPT Modifiers in a comma delimited format, consistent with the HCFA published manuals.

4.8 DATE CPT MODIFIER EXTRACTED
This is the date the patient record extracted for billing. This date is also being used to trigger a mail message to billing if the PSAS HCPCS is edited and changed after the extraction has been ran.

4.9 HCPCS-ICD9 CODING FLAG
This field is used to determine the current code set versioning of a transaction.

4.91 CODING FLAG DATE
This is the date associated with field number 4.9. The date the coding flag was set.

5 QTY
This is the number of units that was issued or repaired for this transaction.

6 SHIP/DEL
This is the charge associated with shipping.

6.5 PICKUP/DEL
This field is a set of codes to identify pickup/delivery charges on VAF 10-2319.

7 VENDOR
The vendor is a pointer to IFCAP's VENDOR file and is the name of the company from which this appliance was or is to be purchased. The vendor may or may not be the same as the manufacturer. Therefore, manufacturers should also be listed in this file as vendors if you are going to be purchasing directly from the manufacturer.

8 STATION
The station is the Veterans Affairs site where this transaction is to come to completion. It is the station that is ultimately responsible for the issue and payment for the prosthetic device. This is the station reporting the workload.

8.1 SUSPENSE DATE
This is suspense date (.01 field).

8.11 SUSPENSE STATION
This refers to the consulting station.

8.12 PCE
This field is pointer to (Patient Encounter). When an entry is created in PCE a pointer is being set.

8.13 DATE SENT TO PCE
This is the date last sent or edited in PCE. If PCE is deleted this field should be deleted.

Continued on next page
Select Custom Data, Continued

8.14  SUSPENSE STATUS
This is the suspense status of the patient 2319 record. If the status is complete, a suspense link was established. If the status is incomplete, there is no suspense link to the patient 2319 record.

8.2   DATE RX WRITTEN
This is the date the prescription was written.

8.3   INITIAL ACTION DATE
This field is the date when an initial action was entered in suspense.

8.4   COMPLETION DATE
This is the date the suspense was completed.

8.5   TYPE OF REQUEST
This field could either be ROUTINE PROSTHETICS, EYEGLASS, CONTACT LENS, OXYGEN, MANUAL NONCPRS or CLOTHING ALLOWANCE.

8.6   SUSPENSE REQUESTOR
This is a pointer to file #200, the person requesting the suspense as it appears in file #668.

8.61  CONSULT REQUEST SERVICE 4
A service/section of a suspense requestor that initiated a consult for Prosthetics item. This free text entry is a service/section name of SERVICE/SECTION.

8.7   PROVISIONAL DIAGNOSIS
This is a free text diagnosis as it appears in suspense file.

8.8   SUSPENSE ICD9
This is the code at the time suspense was created.

8.9   CONSULT
This is a pointer to Consult file.

9   SERIAL NBR
This is the serial number of the issued or repaired appliance. If the serial number is longer than 20 characters, use the FIRST 20 characters.

9.1   PRODUCT DESCRIPTION
The manufacture product description to be used for recalls.

9.2   PRODUCT MODEL
The manufacture product model number to be used for recalls.
Select Custom Data, Continued

10 DELIVERY DATE
This is the date that the appliance was delivered and accepted by the patient. This date, under certain circumstances, may be a date that the appliance was mailed to the patient. It may or may not be the same as the transaction date and/or the request date.

11 FORM REQUESTED ON
The FORM REQUESTED ON is based on current VA regulations. The system makes no checks to be sure that the form entered from the set of codes is within these regulations.

'1' FOR PSC
'2' FOR 2421
'3' FOR 2237
'4' FOR 2529-3
'5' FOR 2529-7
'6' FOR 2474
'7' FOR 2431
'8' FOR 2914
'9' FOR OTHER
'10' FOR 2520
'11' FOR STOCK ISSUE
'12' FOR INVENTORY ISSUE
'13' FOR HISTORICAL DATA
'14' FOR VISA
'15' FOR LAB ISSUE-3

12 SOURCE
This set of codes denotes which two possible sources were used for the acquisition of the appliance. The sources are grouped into either VA sources or commercial sources.

13 ACTION
The action taken on this transaction is noted here. The set of codes is self explanatory; however, the inactive action is used to indicate that the appliance is no longer being followed by VA.

QTY:

'1' FOR LOAN
'2' FOR CONDEMNED
'3' FOR RETURNED
'4' FOR INACTIVE
'5' FOR LOST

14 TOTAL COST
This field contains the total cost of the transaction.

Continued on next page
Select Custom Data, Continued

15  **HISTORICAL DATA**
If this field contains an asterisk (*), then this transaction has been counted by the AMIS option, or is considered to be a historical transaction.

16  **REMARKS**
A free-text field used to indicate any additional information that is needed for this entry. For Purchasing Transactions this field will contain the remarks for the individual item, and the close-out remarks added together.

17  **RETURNED STATUS**
The status of the appliance upon return to the veteran. This notes what action was taken by the repair depot or station upon the completion of repairs.
   '1' FOR RETURNED
   '2' FOR CONDEMNED
   '3' FOR CANCELLED
   '4' FOR TURNED-IN
   '5' FOR LOST
   '6' FOR BROKEN

17.5  **RETURN STATUS DATE**
This is the date upon which the return status was determined and carried out if the item was returned to the veteran.

18  **STATUS FLAG**
The status of the patient is entered here so the service can determine if the patient is being followed, dropped, transferred, or canceled by this station.

21  **LOT NUMBER**
This field stores the lot number of the item being furnished to the patient. Enter the manufacturer's lot number, if known.

22  **PRODUCT LINE**
Set of codes that contain information for Hearing Aid transactions.
   '1' FOR HEARING AIDS
   '2' FOR BATTERIES
   '3' FOR OTHER

23  **TRANSACTION**
This is the IFCAP transaction number from VAF 4-1358 or VAF 2237. A temporary Transaction number for a VAF 10-2529-3 may also be entered.

24  **DESCRIPTION**
This is a detailed description of the item/service supplied.
25 DELIVER TO
Delivery location that will print on VAF 10-2421 to show the vendor where the item will be delivered.

27 INITIATOR
This is the person who created the transaction.

28 EXTENDED DESCRIPTION
This is the extended information from purchasing and also from posting of VAF 2237s.

29 INVENTORY POINT
This is the inventory point for this transaction and is a pointer to the GENERIC INVENTORY.

31 BILL DATE
This is the DATE/TIME the bill is created.

32 BILL STATUS
This is the status of a bill in relation to Integrated Billing.
   '1' FOR ENTERED/NOT REVIEWED
   '2' FOR REVIEWED
   '3' FOR AUTHORIZED
   '4' FOR PRINTED
   '5' FOR TRANSMITTED
   '7' FOR CANCELLED
   '0' FOR CLOSED

33 BILL IEN
This is the bill IEN in file #399.

35 USER WHO EDIT
User who edited the 2319 record using option ED2. This field will only be populated when the Total Cost field has been changed.

36 DATE EDITED
This is the date the Total Cost field has been changed using option ED2.

37 HCPCS/ITEM
This is the PIP HCPCS unique item.

38 HCPCS/ITEM DESCRIPTION
This is the description of an Item or Appliance kept by local site. This field is updated during the STOCK ISSUE options.
Select Custom Data, Continued

38.1 EXCLUDE/WAIVER
This field determines if the item is EXCLUDED or Waiver off of a National Contract.
  'E' FOR EXCLUDED
  'W' FOR WAIVER

38.7 CONTRACT #
This field stores the Contract Number.

40 REQUESTING STATION
This is the station requesting services or appliances.

45 TOTAL LABOR HOURS
This is the number of hours spent on the job. This field is only populated via routines.

46 TOTAL LABOR COST
The total cost of the labor to perform this job.

47 TOTAL MATERIAL COST
The total cost of all the materials to perform the job.

48 TOTAL LAB COST
The Prosthetic Laboratory Total Cost calculated by AMIS.

50 COMPLETION DATE
The date the job was completed.

51 LAB REMARKS
A free-text field used to indicate any additional Laboratory information that is needed for this entry. Since the field is only 40 characters in length, use meaningful abbreviations where possible.

52 AMIS NEW CODE
This field is set when AMIS is generated. It is the New Worksheet AMIS code.

60 AMIS DATE
The date AMIS was run and the item was picked up and counted.

62 PATIENT CATEGORY
This is the Prosthetic Patient Category used for counting AMIS.
  '1' FOR SC/OP
  '2' FOR SC
  '3' FOR NSC
  '4' FOR NSC/OP

Continued on next page
Select Custom Data, Continued

63 SPECIAL CATEGORY
If the patient is NSC/OP, then this field must also be set. SPECIAL CATEGORY is also used in counting AMIS.

'1' FOR SPECIAL LEGISLATION
'2' FOR A&A
'3' FOR PHC
'4' FOR ELIGIBILITY REFORM

64 ADMIN REPAIR AMIS CODE AM
This field will be set when AMIS is generated for the Repair Worksheets.

68 AMIS GROUPER
This is used in AMIS calculations. This field should never be changed through FileMan!

69 SOURCE OF PROCUREMENT LB
The source from which the Purchasing Agent is ordering the needed equipment. The sources one may choose from are limited.

'O' FOR ORTHOTIC LAB
'R' FOR RESTORATION LAB
'S' FOR SHOE LAST CLINIC
'W' FOR WHEELCHAIR REPAIR SHOP
'N' FOR NATIONAL FOOT CENTER
'D' FOR DENVER DISTRIBUTION CENTER

70 RECEIVING STATION
This field contains the institution that will receive the VAF 10-2529-3 request for processing.

71 WORK ORDER NUMBER
Work Order Number (STA-FY-QTR-TYPE OF LAB-NUMBER) for items processed in the Prosthetic Laboratory.

72 2529-3
VAF 10-2529-3 information will be displayed if the VAF 10-2319 item is associated with a Denver Distribution Center, National Foot Center, or Prosthetics Lab request.

73 LAB AMIS DATE
Last date the Lab AMIS was run.

74 ORTHOTICS LAB CODE
Contains the Orthotic Lab New Code.

75 ORTHOTICS LAB REPAIR CODE LBA
Contains the Orthotic Lab Repair Code.

Continued on next page
Select Custom Data, Continued

76  RESTORATION LAB CODE LBA
Contains the Restoration Lab New Code.

77  RESTORATIONS LAB REPAIR CODE LBA
Contains the Restoration Lab Repair Code.

78  UNIT OF ISSUE
This is the unit by which items/services are issued (e.g., each, pair, box, case, etc.).

79  AMIS FLAG
Contains the status if the Item will not count on the Administrative AMIS.

80  WORK FOR OTHER STATION LB
Contains the Status if the Job Performed will display as work performed for another station.
'1' FOR YES

81  NO ADMIN COUNT
This field will be set if the Item will not count on the Administrative AMIS or the Orthotic Laboratory AMIS.
'1' FOR NO COUNT

82  NO LAB COUNT
Field will be set if there is no AMIS Count for AMIS.
'1' FOR NO COUNT

83  BACKLOG DATE
This field will contain the date that the entry was created. This entry will be a backlog entry until it has been completed. All backlog data must show up on the Laboratory or Restoration AMIS Count.

89  HISTORICAL ITEM
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

90  HISTORICAL STATION
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

91  HISTORICAL VENDOR
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

92  HISTORICAL VENDOR PHONE HSTV
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

Continued on next page
Select Custom Data, Continued

93  **HISTORICAL STREET ADD**
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

94  **HISTORICAL CITY**
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

95  **HISTORICAL STATE**
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

96  **HISTORICAL ZIP**
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.

97  **HISTORICAL RECORD**
This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported.
Print the NPPD Detail

Print the data
You can print the NPPD Detail Display data. Click the Print button to send this data to your local printer, and click OK on the Print dialog box. (You can also click the File Menu and the Print option.)

Shortcut: Press the <Ctrl> key + <P> key.

The layout of the print will be the same as the display.

Note: You can select a printer to print the NPPD detail.

Change to Landscape
Recommendation: You should change the format of the printout from Portrait to Landscape to print all the columns on the same page.

Steps
To change the print format, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Print button on the NPPD Detail Display window.</td>
</tr>
<tr>
<td>2</td>
<td>Click the Properties button (to the right of the Name field) on the Print dialog box.</td>
</tr>
<tr>
<td></td>
<td>Shortcut: Press the &lt;Alt&gt; key + &lt;P&gt; key.</td>
</tr>
<tr>
<td>3</td>
<td>Continue to the next page.</td>
</tr>
</tbody>
</table>

Print dialog box

Continued on next page
Print the NPPD Detail, Continued

Layout Tab
You can change the format of the printout from the standard Portrait format to Landscape on the Layout tab.

Steps (continued)
To continue to change to the Landscape format, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Click the Layout tab on the Properties dialog box (usually shown as a default view).</td>
</tr>
<tr>
<td>5</td>
<td>Click the Landscape radio button to change the format. <strong>Shortcut:</strong> Press the &lt;Alt&gt; key + &lt;L&gt; key.</td>
</tr>
<tr>
<td>6</td>
<td>Click OK or press &lt;Enter&gt;.</td>
</tr>
</tbody>
</table>

Landscape Radio button

Last step
When you return to the Print dialog box, click OK again, and it will print your output. You can print multiple copies if necessary.
Save as an Excel File

Excel Button
Click the **Excel** button on the **NPPD Detail Display** window to launch Excel and display the current data. (You can also click the **File** menu and select the **Excel** option.)

**Shortcut:** Press the `<Alt>` key + `<X>` key to launch MS Excel.

**Note:** This feature creates a temporary Excel .CSV file in the folder selected. The default folder is C:\NPPDDownload (which is automatically created). The file name is based on the date range.

**Example:** Jul 02, 2006_Aug 10, 2006.csv

Prior to the display, you are notified that the information about to be exported may contain Patient Identifiable Information.

Steps
To export data to Excel:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the <strong>Excel</strong> button on the <strong>NPPD Detail Display</strong> window.</td>
</tr>
<tr>
<td></td>
<td><strong>Shortcut:</strong> Press the <code>&lt;Alt&gt;</code> key + <code>&lt;X&gt;</code> key.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>OK</strong> button on the security reminder.</td>
</tr>
<tr>
<td>3</td>
<td>Continue to the <strong>Select Directory</strong> window.</td>
</tr>
</tbody>
</table>

Security Reminder

The data you are about to export may contain Patient Identifiable Information, which requires appropriate resources to ensure its confidentiality. Please select only a secure, encrypted location to save the data.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Navigate to the desired directory and select <strong>OK</strong>. (Click <strong>Cancel</strong> to exit or <strong>Help</strong> to view the help pages associated with this functionality)</td>
</tr>
</tbody>
</table>
Select Directory

Step 5: Navigate to a secure location where the temporary Excel (.csv) file will be stored and then select OK. Excel will open and display the data.

MS Excel data
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 6    | This is only a temporary file so if you wish to save the data you must select **File**, then **Save As**, then change the name of the file.  
**Note:** To save the file, you **must** change the filename from the default. If you accept the default file name, it will be deleted when you close the NPPD window. |

**Temp file location**

Should you wish to check the location of the temp file, it displays on the NPPD Detail Display window right above the Excel button.

**Note**

You will be unable to export another report to Excel or navigate away from the NPPD Detail Display window until the current Excel (.csv) file is closed. Attempting to do so without first closing the file will result in one of the following errors depending on what action has taken place. If you do save a file with Patient Identifiable Info in it, don’t forget to delete it when you no longer need it.

**Attempting to Open another report with temp file still open**

**Attempting to navigate away from the NPPD Detail Display window with temp file still open**
Exiting the NPPD Detail Display Window

Exit the Window

You can exit the application by first clicking the **Menu** button on the NPPD Detail Display window. This closes the NPPD Detail Display window.

NPPD Detail Display “Menu” button

Then click the **Close** button on the **Prosthetics Main Menu** window:

Exit the Application
Main Menu
“Close” button

Confirmation window
Click OK on the confirmation window to close the Prosthetics VistA Suite.

Cancel button
If you click the Cancel button, you will remain in the application and can continue to work.
Section 3
Automated Delayed Order Report (DOR)

Overview

Introduction
The Delayed Order Report (DOR) User Manual corresponds to Patch RMPR*3*59. This patch provides Prosthetics GUI (graphical user interface) windows for the Delayed Order Report (DOR) feature.

Note: Using this feature requires basic MS Windows skills.

Prosthetics users can do the following with this patch:

• Search for and display manual suspense entries/electronic consult (CPRS order) data by one or all sites

• Display data using one or multiple statuses (Open, Pending, Cancelled or Closed)

• Use a starting date for Closed and Cancelled records to display data

• Sort and rearrange the view; display data in a custom view

• Print the display

• Convert the display into a Microsoft Excel file (for more sorting capabilities)

Working Days
A delayed order is counted in Working days not Calendar days. This does NOT include Saturdays and Sundays or Holidays!!!

Record Status
The Status column shows the following status types:
1. Open
2. Pending
3. Closed
4. Cancelled

Continued on next page
Overview, Continued

Status cycle

The Initial Action Date displays the date of the first action taken on the suspense entry/electronic consult (CPRS order) record. This changes the status from OPEN to PENDING. An order remains in PENDING status until it is fulfilled and then changes to a CLOSED status.

Note: The status can change from OPEN to CLOSED if the order has been fulfilled upon the initial action.

Keep in mind that when creating the first action note, the status changes from OPEN to PENDING and when creating the second or additional action note(s), the status remains PENDING. Only when a record is completed does the status change to CLOSED.

When a complete note is posted, all action has taken place for a requested Prosthetic item or service. When you post the complete note, the status on the record changes from PENDING (if action has previously taken place on the request) or OPEN to a CLOSED status.

Work Days, not Calendar Days

The Delayed Order Report displays the number of “Work“ days (not Calendar days) from the original date the order was entered as an electronic consult or a suspense entry to the day it is completed. A “Work” day is defined as Monday through Friday.

Note: The calculation subtracts Saturdays and Sundays and Holidays from the number of days the order was entered, even if a CPRS order was written over a weekend. Holidays are NOT counted.
Display the DOR Data

Introduction

General steps to view DOR Data

To utilize the Delayed Order Report (DOR) data, here is a general set of steps to display DOR data as follows:

1. Select ALL sites by checking the “Or…All Sites” checkbox (or you can select a specific site from the drop down list).
2. Enter a Starting Date (defaults to the current date).
3. Select a Status if you want to change the default statuses. The default statuses are set to Open, Pending, and Closed.
4. Enter the SSN range of the patient display (mandatory).
5. Click the Display button.

Description

The Description is a free-text field that is manually entered with approximately 15 characters in length. If you can’t view the entire description, you can expand the column by clicking and dragging the borderline to a wider position.

Data displayed

The data that is displayed with this GUI feature includes the following:

Grid Columns:
- Site
- Delayed column (Yes or No)
- Status of the order
- Type of Order – Manual Suspense or Routine (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders)
- Station number
- Create Date (Suspense entry date)
- First Action Date – Date that the order was put into PENDING status
- Number of Days that the order has been delayed including columns for: 0-5, 6-9, 10-29, 30-90, and 90+ columns
- Link information – linked message(s) to the order record
- Brief description
- Patient name
- Social Security Number

Fields:
Selection Result Totals (near bottom of window) include:

- Total records found
- Total delayed records by calculation
- Percent delayed records by calculation
Select a Site(s)

Select Site

The first thing you must do to view the DOR is to select a site for the records that you want to display. If you are a multi-site facility, you will be able to select the specific site you want to view via the drop down box. **Recommendation**: It is highly recommended that you select the “Or...All Sites” checkbox.

Steps

To begin the process to display the DOR data, follow this first step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the “Or...All Sites” checkbox to view ALL sites and CBOC data.</td>
</tr>
</tbody>
</table>

DOR window

If you want to view all available suspense entries/electronic consult orders including Community Based Outpatient Clinics (CBOC) data, click the All Sites checkbox instead of selecting your specific site from the Site drop-down list box. This ensures that the display will include all sites. For example, the Kenosha, Wisconsin CBOC will not display when the Milwaukee site is selected only. These records display when the All Sites checkbox is selected.
Select a Starting Date

Date/Calendar
Note the Starting Date defaults to the current date. You can change this date. Enter a Starting Date by clicking on the drop-down list box. A calendar displays with the current date circled in red and shown at the bottom of the calendar. You can accept the current date by clicking on it.

Steps
To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Enter a Starting Date (defaults to the current date).</td>
</tr>
</tbody>
</table>

Date
You can change the date by the following methods:

<table>
<thead>
<tr>
<th>Change the…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Click on the actual day of the week in the calendar.</td>
</tr>
<tr>
<td>Month</td>
<td>Click on the month at the top of the calendar to display a list of all months and select one. Or you can decrease or increase one month at a time by clicking the left or right arrows.</td>
</tr>
<tr>
<td>Year</td>
<td>Click on the year and an up and down arrow button displays for you to increase or decrease the year.</td>
</tr>
</tbody>
</table>

Starting date calendar

[Image of the starting date calendar interface]
Select a Status

Status
You can view Open, Pending, Closed or Canceled records by clicking the checkbox for one or all of these options. The default statuses that are already checked are: Open, Pending and Closed. You can click in these boxes to uncheck any status.

Steps
To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Select a Status if you want to change the default statuses.</td>
</tr>
</tbody>
</table>

Status Scenarios
There are a number of combinations that you can choose including the following status scenarios:

Scenario 1: If you select the Open and Pending statuses, you will view all suspense records/electronic consult records (CPRS orders) available with a status of Open and Pending.

Scenario 2: The Starting Date field works with the Closed and Canceled statuses. If you check either one of these statuses, you can then select the Starting Date to display these records. (The Starting Date field that you select plus Closed Delayed records for that period does NOT affect the Open and Pending status record display.)

Scenario 3: If you select all four statuses, you will view ALL Open and Pending records. You will also view the Closed and Canceled records beginning with the Starting Date you select ONLY.
Select the SSN Range

SSN fields

You must have an SSN range to view DOR data. There is a **Starting SSN** and an **Ending SSN** field box. This is a range of patient Social Security Numbers by the last two digits. When you enter a range, it will display electronic consults or manual suspense entries within that range.

If your workload is categorized by the SSN for a specific Purchasing Agent, then you can display entries that are assigned by one Purchasing Agent at a time.

**Note:** Enter a range of 00 to 99 to view all Purchasing Agents’ SSNs for all patients.

Steps

To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Enter the SSN range of the patient display (mandatory).</td>
</tr>
</tbody>
</table>

SSN range

![SSN range image]

Press to DISPLAY the requested data
Display the Data

Data display

The data displayed are manual suspense and all other consult entries. You’ll notice columns with a breakdown of days of 0-5, 6-9, 10-29, 30-89 and 90+ columns.

These columns display the total number of days old by category within the breakdown of the columns. It does NOT display the total number of instances of records (manual suspense entries or electronic consults via CPRS orders).

Steps

To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Once you have the desired criteria, click the Display button. (You can also double click a record to view the Request window.)&lt;br&gt;Shortcut: Press the &lt;Alt&gt; key + &lt;D&gt; key.</td>
</tr>
</tbody>
</table>

Sizing and Sorting columns

Columns are sizable on this window, but not movable. To resize a column, you can place the cursor on the column header borderline until you can view the double-headed arrow. Then click and drag the column until it is the size you want.

To sort the columns, click the column header and the data will redisplay in ascending or descending order. **Note:** Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

Delayed Order Report window

Continued on next page
Display the Data, Continued

Menu, Refresh and Clear buttons
The Menu button returns you to the Prosthetics Main Menu window where you can open additional applications at the same time. The Refresh button resets (recalls) the data if you had made some column sizing changes. It is the same as clicking the Display button again. You can use the Clear button to blank out the window and start over with new display criteria.

Column titles
Below are the header titles of each column and a description of each.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dlyd</td>
<td>The Delayed column will display either a Yes or No as to whether the record is delayed or not. You can sort on this column by all “Yes” records or all “No” records by clicking on the column.</td>
</tr>
<tr>
<td>Status</td>
<td>The Status of the record is either Open, Pending, Closed or Cancelled. Records with an Open status are shown in blue.</td>
</tr>
<tr>
<td>Type</td>
<td>This is the Type of record - Manual Suspense entry or Routine Consult (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders).</td>
</tr>
<tr>
<td>Station</td>
<td>This is the Station Identifying number.</td>
</tr>
<tr>
<td>Create</td>
<td>The Create date is the date that the record was created.</td>
</tr>
<tr>
<td>1st Action</td>
<td>The First Action date is the date that initial action was taken on the request and the status changed from Open to Pending.</td>
</tr>
<tr>
<td>0-5</td>
<td>The number of days (0-5) that an order record is not delayed.</td>
</tr>
<tr>
<td>6-9; 10-29; 30-89; 90+</td>
<td>These columns of number ranges designate the number of Workdays within these ranges that a request has been delayed. This does NOT include Saturdays and Sundays nor Holidays. This also designates that the record is in a Pending status. Any record over 5 days is highlighted in red with yellow numbers.</td>
</tr>
<tr>
<td>Note:</td>
<td>The numbers listed in each row for a record designate the number of days NOT the number of record instances.</td>
</tr>
<tr>
<td>Lnk</td>
<td>The Link column designates how many items that were linked to that record. It could be a zero or a number. Note that if the status is Closed, and there is a zero in the Link column, then those records were never linked.</td>
</tr>
<tr>
<td>Description</td>
<td>This is the description of the request.</td>
</tr>
<tr>
<td>Patient</td>
<td>The patient name is displayed.</td>
</tr>
<tr>
<td>SSN</td>
<td>The Social Security Number for the patient is displayed.</td>
</tr>
</tbody>
</table>

Yellow and Red fields
Records that have a delayed date beyond 5 days will have the number of days in yellow and the block will be highlighted in red.

Records with 0-5 days will have the number shown in bold print.
View DOR Calculation Detail

**DOR Detail button**
You can view the DOR calculation detail for the range of consults and manual suspense entries that you displayed. When you select the **DOR Detail** button, it doesn’t matter what status is checked because the calculation looks at all the **Open**, **Pending** and **Closed** records from the starting date you selected.

---

**Number of MANUALS**
You can view the total number of **Manual** suspense entries that are in **Open**, **Pending** or **Closed** status. Those in the 6-9 or higher columns show the ones that are Delayed.

---

**Number of CONSULTS**
You can view the total number of electronic Consults (that were not entered manually) that are in **Open**, **Pending** or **Closed** status and have not had any action taken on them. Those in the 6-9 or higher columns show the ones that are Delayed.

---

**SUB TOTAL**
The **SUB TOTAL** row totals the number of **Manual** suspense entries + the total number of all other consults.

---

**DOR Calculation Detail window**
This row displays the number of consults that have had an initial action taken on it (starting with the date you selected in the calendar for the starting date which is shown here by 1/1/2003) and put into a **Pending** status.

This number is subtracted from the subtotal for the **Total Delayed** row below that.

---

**Minus PENDING**

**Continued on next page**
The **TOTAL DELAYED** is calculation that adds the total number of *Manual* Suspense records + the total number of all other consults and subtracts the number of consults in a *Pending* status (Pending from before the Start Date selected).

The **Total of the Sub Total** field includes: 1) the total from the **Sub Total** above (third row), 2) all totals of *Manual* Suspense entries and 3) all other electronic consults.

The next row shows the calculation for the Total consults minus the **Pending** consults from the starting date that you selected.

The **TOTAL DELAYED** field is shown.

This displays the Total Delayed from the grid above (any greater than 5 days delayed) divided by (the result of the total Sub Total minus Total Pending as of 1/1/03) and multiplied by 100. This is the percentage delayed.

The final calculations above, this equals the **Percent Delayed** (shown as 95.37%).

*Continued on next page*
View DOR Calculation Detail, Continued

Scenarios below

The scenarios below describe different timelines when orders are received at different times of the month and if they are delayed. Then it will explain which month’s Calculation Report where the data will appear.

Scenario 1

An order is received on Tuesday, June 3rd and is changed to Pending or Closed status on Friday, 6/6. This is not a delayed order and would appear in the June Calculation Report as an order received.

Scenario 2

An order is received on Tuesday, 6/3 and is changed to Pending or Closed on Wednesday, 6/20. This is a delayed order and would be included in the June Calculation Report as a delayed order.

Scenario 3

An order is received on Thursday, 6/26 and is changed to Pending or Closed on Tuesday, 7/15. This was not a delayed order in June; however, the order is included in the June Calculation Report, because it was received in June. Since it took greater than 5 days to change it to Pending or Closed, it would also be included in the July report as a delayed order and would be included in the calculations.

Scenario 4

An order is received on Thursday, 6/26 and changed to Pending or Closed on Monday, August 4th. This is not a delayed order in June; however, the order is included in the June Calculation Report, because it was received in June. Since it took greater than 5 days to change it to Pending or Closed, it would be included in both the July and August report as a delayed order and would also be included in the calculations.

Continued on next page
Print button

You can print the DOR Calculation Detail data by clicking the Print button. A Print Preview pane will display that allows you to zoom in, scroll forward/backward, print, save the data, or open/load a new report.

Click the Close button to return to the DOR Calculation Detail window.

Print Preview

![Delayed Order Report - Calculation Details]

- **Source:** SSCSL
- **Date:** 6/5/2003

<table>
<thead>
<tr>
<th>Site</th>
<th>Open - Yes</th>
<th>Cancelled - No</th>
<th>Starting SSN</th>
<th>80</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>6/9/2002</td>
<td>Pending - Yes</td>
<td>Closed - Yes</td>
<td>Ending SSN</td>
</tr>
</tbody>
</table>

**Delayed Order Analysis**

- **Days > 0:** 63
- **6-10:** 78
- **12-15:** 87
- **15-30:** 15
- **30+:** 1

- **Number of MANUALS:** 403
- **CONSULTS:** 698
- **Sub TOTAL:** 1101

- **Days to 1st Action:**
  - **Days > 0:** 63
  - **6-10:** 78
  - **12-15:** 87
  - **15-30:** 15
  - **30+:** 1

- **Total Delayed:** 4228

**Notes:**

- **Total of the SUB TOTAL:** 4721
- **Minus the Total of the PREVIOUS PENDING:** 200

**TOTAL DELAYED:** 4228

**Divisible by:** 4431

**X 100 Equals PERCENT DELAYED:** 95.37
View Pending Calculations

Pending Calc Button
Click on the Pending Calc button on the DOR window and the window displays based on the selection criteria of this window.

Pending status consults
The Pending Calculations window displays the total number of Workdays with the total number of Pending records since an initial action was taken on it. These records are categorized into columns by the number of Workdays it has remained in a Pending status.

The calculation used to display these Pending status records is from the First Action date (not from Creation Date) to the current date. This is a tool to help managers monitor their consults and manual suspense entries that have been Pending for an extended period of time.

Pending Calculations

Print button
The Print button allows you to print the Pending Action Calculations and will display the Print dialog box.

Excel button
You can send this data to MS Excel by clicking the Excel button. It will launch the application and display the data at the same time. (You can also click the File menu, click Excel, then select the Send - Request Grid option.)

For more information on saving data as an Excel file, see “Save as an Excel File,” later in this chapter.
Close button

To exit, click the Close button or the button in the top right-hand corner.
View 2319 Information

View 2319 – Patient Demographics

Introduction

The View 2319 button displays the 10-2319 Prosthetic patient records. The title bar displays the patient name and SSN. Here are the windows of information that you can view from the patient’s 2319:

1. Patient Demographics
2. Clinic Enrollments/Correspondence
3. Entitlement Info
4. Appliance Transactions
5. Auto Adaptive Info
6. Critical Comments
7. HISA Information
8. Home Oxygen Items

Note: Use the <Alt> key and the number to toggle to different tabs.

Demographics data

You can view the patient demographics for the veteran. This includes: Name (in red if deceased with Date of Death listed above the Date of Birth and the age field will not display), address, next of kin, emergency contact information, veteran benefits and eligibility (former Prisoner of War (highlighted in blue if “Yes”), Aid & Attendance, service connected, non-service connected, etc.).

1. Patient Demographics window

Demographics data

View 2319 – Patient Demographics

DDHYHU,CXHA

Address: 44010 ALANDEN DR

City: REYNOLDS CANYON

State: ALABAMA

Zip: 73546

Phone: (503) 652-6418

County: COWETA

DDHYHU,CXHA

Address: 54860 ALANDEN DR

City: EDEN GARDEN

State: ALABAMA

Zip: 36620

Phone: (503) 474-4615

County: COWETA

Benefits & Eligibility

Claim #: SS

Patient Type: GG VETERAN

Period of Service: KOREAN

Ph Eligibility Code: SS LESS THAN 59

Eligibility Verified: VERIFIED

P.O.W.: NO

Receiving: A.A.A: NO

Housebound: NO

VA Pension: NO

VA Disability: YES

Total Annual Amount: $1,141.06

Disability Code: ADHD SCATTASDCV NCS

Disability: DIABETES MELLITUS yes

DEAFNESS MILD yes

IMPAIRMENT HEARING Y

Emergency Contact

Name: WIFE

Address: 44010 ALANDEN DR

City: REYNOLDS CANYON

State: ALABAMA

Zip: 73546

Phone: (503) 652-6418

Relation: WIFE

Next of Kin

Name: WIFE

Address: 54860 ALANDEN DR

City: EDEN GARDEN

State: ALABAMA

Zip: 36620

Phone: (503) 474-4615

Relation: WIFE

March 2005

Prosthetics VistA Suite (GUI)

User Manual
View 2319 - Clinic Enrollments/Correspondence

Window description

This second tab details clinic enrollments and correspondence for the veteran. This includes the following: the last movement actions (i.e., hospital admissions and discharges), clinic enrollments, pending appointments and correspondence letters.

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

2. Clinic Enrollments/Correspondence

Exit

To exit, click the Close button or the button in the top right-hand corner.
The third tab details entitlement and loan information for the veteran. This includes the following: PSC Issue Card, clothing allowance, items on loan, and items returned.

To exit, click the Close button or the button in the top right-hand corner.
View 2319 – Appliance Transactions

Appliance Transactions

The Appliance Transactions tab of the View 2319 window displays all transaction history for a veteran. The Date column is the date of the PO. Columns are re-sizeable on this window (not movable). The total records found displays at the bottom.

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

Steps

To view the Appliance Transactions detail, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select a transaction by clicking on it to highlight it.</td>
</tr>
<tr>
<td>2</td>
<td>Click the View Detail button below to display the appliance details. (You can also double click a record to view the details.)</td>
</tr>
</tbody>
</table>

Exit

To exit, click the Close button or the button in the top right-hand corner.

Continued on next page
To continue to view the Appliance Transactions detail, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>The <strong>Transaction Detail</strong> window is shown below.</td>
</tr>
<tr>
<td>4</td>
<td>Click the Close button to return to the Appliance <strong>Transaction</strong> window.</td>
</tr>
</tbody>
</table>

To exit, click the **Close** button or the button in the top right-hand corner.
The fifth tab details the Auto Adaptive information.

To exit, click the Close button or the button in the top right-hand corner.
View 2319 - Critical Comments

Window description

The sixth tab details any critical comments recorded for the veteran.

6. Critical Comments

To exit, click the Close button or the button in the top right-hand corner.
View 2319 – View HISA Information

Window description

The seventh tab details the HISA (Home Improvement Structural Alteration) information including the date, quantity, item, type, vendor, station number, serial, HCPCS Code and cost of the item ordered.

Note: “HISA Information” is the new name for this window; it used to be “Add/Edit Disability Codes.”

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select a transaction by clicking on it to highlight it.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>View Detail</strong> button below to display the HISA information details. (You can also double click a record to view the details.)</td>
</tr>
</tbody>
</table>

7. HISA Information

Exit

To exit, click the **Close** button or the button in the top right-hand corner.
View 2319 – Home Oxygen

Window description

The eighth tab details the Home Oxygen information including the date, quantity, item, type, vendor, station, serial, HCPCS Code, and total cost of the item(s).

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select a transaction by clicking on it to highlight it.</td>
</tr>
<tr>
<td>2</td>
<td>Click the View Detail button below to display the Home Oxygen information details. (You can also double click a record to view the details.)</td>
</tr>
</tbody>
</table>

8. Home Oxygen

Exit

To exit, click the Close button or the button in the top right-hand corner.

View Detail

When you select a record and click the View Detail button, the following window displays as shown on the next page.
View 2319 – Home Oxygen, Continued

**View Detail button**

After clicking the View Detail button on the Home Oxygen window, the following window displays for the patient.

**Transaction Detail window**

![Transaction Detail window](image)

**Close button**

To exit, click the Close button or the button in the top right-hand corner.
View and Manage the DOR

View CPRS

Function description

The View CPRS button from the DOR window allows you to view all the consult data on the View CPRS window as shown below. This is the same data as in the electronic Consult - Suspense (SU) Menu feature where you can enter CD for the CPRS Display.

View CPRS window

To exit, click the Close button or the button in the top right-hand corner.
View Request

Function description
When you click the View Request button on the DOR window, the View Request window displays as shown below. This provides the display of the manual suspense entry for the patient.

Note: You can also double click on a record in the DOR window grid to display this View Request window.

View Request window

Close button
To exit, click the Close button or the button in the top right-hand corner.
Save as an Excel File

Excel Button
Click the Excel button on the Delayed Order Report window to launch Excel and display the current data. (You can also click the File menu, click Excel, then select the Send - Request Grid option.)

Shortcut: Press the <Alt> key + <X> key to launch MS Excel.

Note: This feature creates a temporary Excel .CSV file in the folder selected. The default folder is C:\NPPDDownload (which is automatically created). The file name is based on the number of selected sites and the SSN range.

Examples: DOR_1_00_33.csv means 1 site was selected for SSN range 00-33.
DOR_ALL_34_99.csv means All Sites were selected for SSN range 34-99.

Prior to the display, you are notified that the information about to be exported may contain Patient Identifiable Information.

Steps
To export data to Excel:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Excel button on the Delayed Order Report window.</td>
</tr>
<tr>
<td></td>
<td><strong>Shortcut:</strong> Press the &lt;Alt&gt; key + &lt;X&gt; key.</td>
</tr>
<tr>
<td>2</td>
<td>Click the OK button on the security reminder.</td>
</tr>
<tr>
<td>3</td>
<td>Continue to the Select Directory window.</td>
</tr>
</tbody>
</table>

Security Reminder

The data you are about to export may contain Patient Identifiable Information, which requires appropriate measures to ensure its confidentiality. Please select only a secure, encrypted location to save the data.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Navigate to the desired directory and select OK. (Click Cancel to exit or Help to view the help pages associated with this functionality)</td>
</tr>
</tbody>
</table>
Select Directory

Step 5: Navigate to a secure location where the temporary Excel (.csv) file will be stored and then select OK. Excel will open and display the data.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 6    | This is only a temporary file so if you wish to save the data you must select **File**, then **Save As**, then change the name of the file.  
**Note:** To save the file, you **must** change the filename from the default. If you accept the default file name, it will be deleted when you close the DOR window. |

**Temp file location**

Should you wish to check the location of the temp file, it displays on the DOR window right below the Print button.

**Note**

You will be unable to export another report to Excel or navigate away from the DOR window until the current Excel (.csv) file is closed. Attempting to do so without first closing the file will result in one of the following errors depending on what action has taken place. If you do save a file with Patient Identifiable Info in it, don’t forget to delete it when you no longer need it.

**Attempting to Open another report with temp file still open**

**Attempting to navigate away from the DOR window with temp file still open**
Print the DOR

You can print the DOR data using the Print button to send this data to your local printer. You can also click the File Menu and the Print-Request Grid option, and the Print dialog box displays. The layout of the print will be the same as the display.

**Shortcut:** Press the <Alt> key + <P> key.

**Note:** You can select a different printer that you have setup to print the detail.

When printing grids, the default is set to print in the Landscape format and then returns the printer to the prior state.

To print the DOR, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Print button on the DOR window.</td>
</tr>
<tr>
<td>2</td>
<td>The Print dialog box displays.</td>
</tr>
<tr>
<td>3</td>
<td>Click the Properties button (to the right of the Name field) on the Print dialog box if you want to change the page orientation of the printout. (Optional)</td>
</tr>
<tr>
<td>4</td>
<td>Click the OK button.</td>
</tr>
</tbody>
</table>

![Print dialog box image]
Exiting the DOR Window

Exit the Window

You can exit the application by first clicking the Menu button on the Delayed Order Report window. This closes the DOR window.

DOR “Menu” button

Exit the Application

Then click the Close button on the Prosthetics Main Menu window:
Main Menu
“Close” button

Confirmation window
Click OK on the confirmation window to close the Prosthetics VistA Suite.

Cancel button
If you click the Cancel button, you will remain in the application and can continue to work.
Section 4

View Prosthetics Billing Information

Overview

Introduction

This View Prosthetics Billing Information User Manual is for Patch RMPR*3*96. This patch provides Prosthetics GUI (graphical user interface) windows for the View Prosthetics Billing Information feature.

The Prosthetics and Billing users will be able to do the following with this patch:

- Search for data and display data by a range of dates.
- Sort and rearrange the view; display data in a custom view.
- Print the display.
- Convert the display into a MS Excel file (for complex sorting features).

Audience

These Release Notes are geared towards two audiences. The VistA Sign-on window will appear with different functions according to which type of user is accessing the Billing information. The two audiences for this document and the VistA Sign-on window include:

- Billing users – Section 1
- Prosthetics users – Section 2

Data displayed

The data that is displayed on the View Prosthetics Billing Information window includes the following:

- Site
- Create Date
- Delivery Date
- Patient name
- Social Security Number
- Insurance
- Coding Errors
- Item Description
- Quantity
- Total Cost
- HCPCS
- HCPCS Description
- ICD9
- ICD9 Description
Chapter 1 - For Billing Users

Billing Main Menu Window

Billing Main windows

Below is the Prosthetics Main Menu window where Billing users can first sign-on to VistA (using the VistA Sign-On button) and then access the View Prosthetics Billing Information window. The Billing users will see a “green dollar sign” icon on the desktop to select the Prosthetics feature.

Note: Please see the Prosthetics Main Menu User Manual for more detail information regarding VistA Sign-On instructions.

Prosthetics Main Menu

Billing button

Click the View Prosthetics Billing Information button and proceed to Chapter 3.
# Chapter 2 – For Prosthetics Users

## Prosthetics Main Menu Window

<table>
<thead>
<tr>
<th>Prosthetics Main Menu Window</th>
<th>The <strong>Prosthetics Main Menu</strong> window is also where Prosthetics users can sign-on to VistA and then access the <strong>View Prosthetics Billing Information</strong> window. These users also have access to other Prosthetics features.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>To access this application, you will double click on the <strong>Prosthetics VistA Suite (medicine bag)</strong> icon on desktop. Please see the <strong>Prosthetics Main Menu User Manual</strong> for more detailed VistA Sign-on instructions.</td>
</tr>
<tr>
<td>Billing button</td>
<td>Click the <strong>View Prosthetics Billing Information</strong> button and proceed to the next page.</td>
</tr>
</tbody>
</table>
Chapter 3 – View Billing Information Package

View Billing Information Window

Purpose

You can view Prosthetics billing information, insurance information and disability information for specific veteran using the View Prosthetics Billing Information window.

View Prosthetics Billing Information main window

Menu button

The Menu button will close the View Prosthetic Billing Information window and return you to the Prosthetics Main Menu window.
Enter a Date Range

After you have successfully signed on to VistA, and the View Prosthetic Billing Information window appears, you must select the date range that you want to view. Enter a Beginning Date and an Ending Date by clicking on the drop-down list boxes next to the respective fields. A calendar displays as shown below.

Note: The software will sort by the Create Date field of the Prosthetics Purchase Order or Stock Issue. It does not sort by the Delivery Date field (the date paid).

Shortcut: Press the <Ctrl> key + <B> key for the Beginning Date and the <Ctrl> key + <E> key for the Ending Date to display the respective calendars. You can also click the File Menu and the Select Beginning Date or Select Ending Date option from the list.
Enter a Date Range, Continued

Selecting a date range

The calendars display with the current date circled in red shown at the bottom of the calendar. You can accept the current date by clicking on it. You can also change the date by the following methods:

<table>
<thead>
<tr>
<th>Change the…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Click on the actual day of the week in the calendar.</td>
</tr>
<tr>
<td>Month</td>
<td>Click on the month at the top of the calendar to display a list of all months and select one from there. You can decrease or increase one month at a time by clicking the left or right arrows.</td>
</tr>
<tr>
<td>Year</td>
<td>Click on the year and an up and down arrow button displays for you to increase or decrease the year.</td>
</tr>
</tbody>
</table>

Number of Day Restrictions

You are restricted to a date range of less than 100 days. If you select a date range outside of this 100 day parameter, the following dialog message box displays:

Start Date before End Date

If you accidentally entered an incorrect date range, you will receive a warning message. For instance, if you enter a start date that is after the end date, the message below will display. Click the OK button and reselect your date range.

Start/End Date Message

The Starting Date must be before the Ending Date
Display the Prosthetics Data

Once you have selected the date ranges, click the Display button to reveal the data within that date range. (You can also click the File Menu and the Display option.) A progress bar activates, and the button name changes to “Searching” while the system is retrieving records. (A long date range may result in a long search time.)

**Recommendation:** The larger the date range selected, the greater time it will take to search, sort, and display the data. We recommend that you sort by a short date range (5-10 days) and perform the sort early in the morning or later in the day when your VistA system is less active.

**Shortcut:** Press the `<Ctrl>` key + `<D>` key.

---

**View Prosthetics Billing Information**

![Prosthetics Billing Information](image)

**Please enter a range of dates to View Prosthetic Billing Information**

<table>
<thead>
<tr>
<th>Beginning Date</th>
<th>Ending Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 01, 2004</td>
<td>Mar 15, 2004</td>
</tr>
</tbody>
</table>

**Insurance Information**

- Medicare (WV)
- Medicaid (WV)

**Disability Information**

- Impairment of Finger: 29
- Osteomyelitis: 0
- Neuropathy: 0

**Records Found:** 4213
## Change Data Display

### Changing the display of the data...
You can manipulate the layout of the view in the View Prosthetics Billing Information window for both viewing as well as printing purposes as follows:

- To enlarge a column, click and drag a cell border.
- To sort on any column, click on the header to sort it in ascending order.
- If you click on the same column again, it will sort it in descending order.

### Refresh data
If you have changed the sort order, you can refresh your data by clicking the **Display** button again.

**Note:** Refresh does not reset any column resizing that has been done.
View Column Descriptions - Site, Dates and Patient Data

**Site**
The **Site** column displays the VA facility where the veteran was treated and where the Prosthetics transaction was created.

**Create Date**
The **Create Date** is the date the transaction (Purchase Order or Stock Issue) was created and posted to the Prosthetic veteran’s record (2319).

**Delivery Date**
If the **Delivery Date** field is blank, this indicates that Prosthetics has NOT paid the item; therefore an assumption is made that the veteran may not have received the item.

The **Delivery Date** is not the date the veteran received the item; it is technically the date the Purchase Order was closed or the date the Stock Issue transaction was posted to the 2319.

**Patient**
The **Patient** column contains the veteran’s last name and first name. Only Non-Service Connected transactions display for the requested date range.

**SSN**
The **SSN** column displays the patient’s Social Security Number (SSN).

**Column Headers**

![View Prosthetics Billing Information... You are logged onto VistA.](image)

Please enter a range of dates to View Prosthetics Billing Information...

<table>
<thead>
<tr>
<th>Site</th>
<th>Create Date</th>
<th>Delivery Date</th>
<th>Patient</th>
<th>Suite</th>
<th>Insurance</th>
<th>Coding</th>
<th>Item</th>
<th>Qty</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOMA</td>
<td>1/2/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOMA</td>
<td>1/2/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOMA</td>
<td>1/2/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOMA</td>
<td>1/2/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOMA</td>
<td>1/2/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOMA</td>
<td>1/2/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

156 Prosthetics VistA Suite (GUI) March 2005
User Manual
View Column Description - Insurance Information

**Insurance for a patient**

The **Insurance** column displays health insurance information from the patient’s VistA record.

If there is no health insurance information in the patient’s VistA record, it displays “**Nothing Found**” in the **Insurance** column.

If health insurance displays, then the **most recent** insurance entered into the patient’s VistA record will display.

**Insurance column**

If there is an asterisk (*) in the **Insurance** column, this indicates that there is more than one insurance listed for the patient. If there is no asterisk (*), then there is only ONE insurance listed for the patient in the VistA record.

Click on that line item to display the insurance information in the box below.

**Sorting Tip**

You can sort on the column headers within the **Insurance Information** box to group items together for easier review. For instance, you can click on the **Effective date** column or **Expires date** column headers, and this will group items for reviewing the most recent insurance.

**Effective date column sorted**

View Column Descriptions - Coding Errors

Coding Errors

The **Coding Errors** column is to alert Billing users of a *possible* error. Errors could be any of the following:

- Inactive HCPCS
- Inactive ICD-9 codes
- Use of VA unique HCPCS codes.

The **Coding Errors** column checks the HCPCS code to see if it was valid at the time of service, and if not, then the word “HCPCS” is shown in red as well as the “HCPCS Description” is shown in red. This also applies to the inactive ICD9 Codes.

**Example:** If there is a red HCPCS displayed in the **HCPCS** column, then the **Coding Errors** column will display “Alert HCPCS” for Prosthetics or Billing users. This will provide a mechanism to alert users to review this billing information.

Coding Column

Sorting Tip

You can sort on the **Coding Errors** column by clicking the column header to group items for review.
**View Column Descriptions - Item Information**

**Item definition**

The Item column displays an Item or appliance kept in the Pros Master Item file. This column displays the IFCAP Item description of the Item issued to the Veteran.

**～R～ in the Item column**

An “～R～” displayed in the Item column represents a Repair item. The HCPCS Description column should explain what was being repaired.

The Item column is the “Brief Description” entry that is printed on the purchase order transaction and appears on the 2319 record. The Brief Description is entered to define the item.

**Tip:** You can sort on the Item column by clicking the column header to group items to review all Repair items together.

---

**Item column sorted – Repair items grouped together**

The table below shows a range of dates and a view of Prosthetic Billing Information. The items are sorted by Item column, with Repair items grouped together.

![Prosthetic Billing Information](image)
View Column Descriptions - Quantity and Total Cost Data

**Qty column**
The *Quantity* column provides the number issued of that Item to the veteran. This is the quantity based on purchasing (not units).

**Note:** For Home Oxygen, it is a payment unit not a billing unit.

**Column headers**

**Total Cost column**
The *Total Cost* column represents the cost of the issue.
The HCPCS acronym stands for Healthcare Financing Administration Common Procedure Coding System. The HCPCS code represents an item or service. The Prosthetics staff selects the HCPCS code when the transaction was created.

If the HCPC Code and HCPCS Description in the HCPCS and HCPCS Description columns are red, that represents a HCPCS Code that has a coding error as defined by an Inactive HCPCS.

This provides an alert to Prosthetics and Billing users as this will affect billing information.

If there is an asterisk in the HCPCS column, this indicates that there is a calculation flag.

A calculation flag determines whether or not a HCPCS is used as a Main Component to display the entire cost of a purchase, when multiple items within the purchase make up a whole (e.g., when purchasing a limb or surgical implants).
## View Column Descriptions - ICD9 and ICD9 Description

### ICD9 definition
International Classification of Diseases (Ninth Revision) - A coding system designed by WHO, (World Health Organization). ICD-9-CM is the official system of assigning codes to diagnoses and procedures associated with hospital utilization in the United States.

The ICD –9 is used to code and classify mortality data from death certificates. VOLUMES 1-2 contain diagnosis and procedures. VOLUME 3 is used for statistical, research and re-imbursement purposes.

### Column headers

<table>
<thead>
<tr>
<th>ICD9 Code</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>This code is selected by the prescribing clinician when the Prosthetic consult is created.</td>
<td></td>
</tr>
</tbody>
</table>

### ICD9 Code

- [View Prosthetic Billing Information...](#)
If the patient has disability information, it will automatically be displayed in the Disability Information box in the bottom of the window.

If a patient is selected without any disability information, the Disability Information box at the bottom of the window will display “Nothing Found.”
Chapter 4 - Printing

Print the View Prosthetics Billing Information Window

Print the data
You can print the View Prosthetics Billing Information data after you have finished your sort by column heading. Click the Print button to send this information to your local printer, and click OK on the Print dialog box. (You can also click the File Menu and the Print option.)

Note: The layout of the print will be the same as the display. You can select a specific printer to print the View Prosthetics Billing Information window.

Change to Landscape
Recommendation: You should change the format of the printout from Portrait to Landscape to print all the columns on the same page.

Steps
To change the print format, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Print button on the View Prosthetics Billing Information window.</td>
</tr>
<tr>
<td>2</td>
<td>Click the Properties button (to the right of the Name field) on the Print dialog box. Continue to the next page. &lt;br&gt; <strong>Shortcut:</strong> Press the &lt;Alt&gt; key + &lt;P&gt; key.</td>
</tr>
</tbody>
</table>

Print dialog box

Continued on next page
Print the View Prosthetics Billing Information Window, Continued

**Layout Tab**
You can change the format of the printout from the standard *Portrait* format to *Landscape* on the **Layout** tab.

**Steps (continued)**
To continue to change to the Landscape format, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Click the <strong>Layout</strong> tab on the <strong>Properties</strong> dialog box (usually shown as a default view).</td>
</tr>
<tr>
<td>4</td>
<td>Click the <strong>Landscape</strong> radio button to change the format.</td>
</tr>
<tr>
<td></td>
<td><strong>Shortcut:</strong> Press the &lt;Alt&gt; key + &lt;L&gt; key.</td>
</tr>
<tr>
<td>5</td>
<td>Click <strong>OK</strong> or press &lt;Enter&gt;.</td>
</tr>
</tbody>
</table>

**Landscape Radio button**

**Last step**
When you return to the **Print** dialog box, click **OK** again, and it will print your output. You can print multiple copies if necessary.
### Chapter 5 – Saving

#### Save as an Excel File

**Excel Button**
Click the **Excel** button on the **View Prosthetics Billing Information** window to launch Excel and display the current data. (You can also click the **File** menu and select the **Excel** option.)

**Shortcut:** Press the `<Alt>` key + `<X>` key to launch MS Excel.

**Note:** This feature creates a temporary Excel .CSV file in the folder selected. The default folder is C:\ViewBillingDownload (which is automatically created). The file name is based on the date range.

**Example:** Jul 02, 2006_Aug 10, 2006.csv

Prior to the display, you are notified that the information about to be exported may contain Patient Identifiable Information.

#### Steps
To export data to Excel:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the <strong>Excel</strong> button on the <strong>View Prosthetics Billing Information</strong> window.</td>
</tr>
<tr>
<td></td>
<td><strong>Shortcut:</strong> Press the <code>&lt;Alt&gt;</code> key + <code>&lt;X&gt;</code> key.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>OK</strong> button on the security reminder.</td>
</tr>
<tr>
<td>3</td>
<td>Continue to the <strong>Select Directory</strong> window.</td>
</tr>
</tbody>
</table>

#### Security Reminder

The data you are about to export may contain Patient Identifiable Information, which requires appropriate measures to ensure its confidentiality. Please select only a secure, encrypted location to save the data.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Navigate to the desired directory and select <strong>OK</strong>. (Click <strong>Cancel</strong> to exit or <strong>Help</strong> to view the help pages associated with this functionality)</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
5   | Navigate to a secure location where the temporary Excel (.csv) file will be stored and then select **OK**. Excel will open and display the data.
Step | Action
--- | ---
6 | This is only a temporary file so if you wish to save the data you must select **File**, then **Save As**, then change the name of the file.

**Note**: To save the file, you **must** change the filename from the default. If you accept the default file name, it will be deleted when you close the NPPD window.

**Temp file location**

Should you wish to check the location of the temp file, it displays on the View Prosthetic Billing window right above the Excel button.

**Note**

You will be unable to export another report to Excel or navigate away from the View Prosthetic Billing Information window until the current Excel (.csv) file is closed. Attempting to do so without first closing the file will result in one of the following errors depending on what action has taken place. If you do save a file with Patient Identifiable Info in it, don’t forget to delete it when you no longer need it.

**Attempting to Open another report with temp file still open**

**Attempting to navigate away from the View Prosthetic Billing Information window with temp file still open**

AutoFilter

The AutoFilter feature can limit what is displayed for your view which can be printed for reports. Filtering is a quick and easy way to find and work with a subset of data in a list. A filtered list displays only the rows that meet the criteria you specify for a column.

Steps: On the Data menu, point to Filter, and then click AutoFilter.

When you use the AutoFilter command, arrows appear to the right of the column labels in the filtered list.

Note: Unlike sorting, filtering does not rearrange a list. Filtering temporarily hides rows you do not want displayed. When Excel filters rows, you can edit, format, chart, and print your list subset without rearranging or moving it.
Chapter 6 - Closing and Exiting

Exiting the View Prosthetic Billing Information Window

Exit the Window
You can exit the application by first clicking the **Menu** button on the **View Prosthetic Billing Information** window. This closes the View Prosthetic Billing Information window.

View Prosthetic Billing Information “Menu” button

Exit the Application
Then click the **Close** button on the **Prosthetics Main Menu** window:
Main Menu
“Close” button

Click OK on the confirmation window to close the Prosthetics VistA Suite.

Confirmation window

Cancel button
If you click the Cancel button, you will remain in the application and can continue to work.
Section 5
Creating a Lab Work Order

Overview

The Create application allows you to create an Orthotics Lab Work order (OWL). You may now Complete and Cancel a work order from the Graphical User Interface (GUI). The Create application also allows you view information associated with the current work order, such as 2319 information, CPRS data, and the initial Request. The Create application is accessed from the Purchase Order Control window.

Accessing the Create Lab Work Order window

To access the Create Lab Work Order window from the Purchase Order Control window, do the following:

1. Highlight a work order in the Purchase Order Control listview.

   **Note 1:** The patient must be defined in the PROSTHETICS PATIENT FILE. If you select a patient who is not already defined, a popup message alerts you to this fact. (Click OK to clear the popup window.) Use the AP – Add/Edit Patient to Prosthetics option to correct this issue.

   **Note 2:** A work order that displays LAB in the Type column has already been used to create a lab order and may not be reused for that purpose.

2. Click the Create OWL button. The Create Lab Work Order window displays.

The Create Lab Work Order window shown below displays the name and SSN of the patient that was highlighted on the Purchase Control window when you clicked the Create OWL button.

The name and SSN display in blue letters in the upper-left corner of the screen. The Create Date displays in a yellow field in the upper-right corner.

You will create a Lab Work Order from this window for a specific patient.

**Note:** On this screen, a field with a yellow background cannot be directly edited. The field value defaults in, sometimes as a result of another selection you’ve made.
Create Lab Order window

Quitting Work If you need to stop working at any point during the workflow, click the Quit Work button in the lower-right corner of the window. You will return to the Purchase Order Control window.
Selecting a Lab Type

The first step to creating a Lab Order is to select a Lab Type. Below the patient SSN there are four radio buttons that correspond to the following lab types:

- Orthotics/Prosthetics
- Optical
- Restoration
- Wheelchair

Click one of the Lab Type radio buttons, then mouse click or press <Tab> to go to the next field.
**Selecting Stations**

**NPPD Station**

The National Prosthetic Patient Database (NPPD) is a dynamic, comprehensive national database used to collect information on the disabled population’s use of prosthetic, orthotic, and sensory aids. This information allows for statistical analysis and oversight of the VA Prosthetic Service. The NPPD compiles prosthetic data recorded at each VHA facility, or station.

Click the **NPPD Station** drop-down arrow to display a list of stations for you to select one. A shortcut is to enter a partial spelling of the **NPPD Station** and click the drop-down arrow (or press the <TAB> key) to select one beginning with the criteria that you entered.

Once a station has been selected, the station name displays next to the NPPD Station label and the site number displays in the yellow field to the right.

**Note:** For a user at a station which does its own OWL, the NPPD Station, Receiving Station, and Requesting Station will all be the same.

**Receiving Station**

Enter a partial spelling of the **Receiving Station** and click the drop-down arrow (or press the <TAB> key) to select an item beginning with the characters you entered. The Receiving Station is the institution that will receive the VAF 10-2529-3 request for processing.

**Requesting Station**

Enter a partial spelling of the **Requesting Station** and click the drop-down arrow (or press the <TAB> key) to select an item beginning with the characters you entered. The Requesting Station is the station requesting the services or appliances.
Patient Category and Type of Transaction

Patient Category

The next step is to select a Patient Category. To the right of the patient SSN there are two radio buttons that correspond to the following patient categories:

- SC (service connected)
- NSC (non-service connected)

Click one of the Patient Category radio buttons.

Shortcut: Press the <Tab> key to move focus to the Patient Category area, then use the arrow keys to select a Patient Category.

For your reference, a listview to the right of the Patient Category area displays disabilities on record for the current patient. This listview displays the following three columns:

- Disability
- % (percentage of disability)
- SC (service connected – yes or no)

The SC column displays YES if the disability is service connected and NO if otherwise.

You may sort this display by clicking any one of the column headings.

Type of Transaction

Below the Patient Category area there are two radio buttons that correspond to the following transaction types:

- New / Replace
- Repair / Service

Click one of the Type of Transaction radio buttons.

Shortcut: Press the <Tab> key to move focus to the Type of Transaction area, then use the arrow keys to select a Type of Transaction.
# Primary Item Information

**Billing Item**  
Enter a partial spelling of the **Billing Item** and click the drop-down arrow (or press the `<Tab>` key) to select an item beginning with the characters you entered.

**HCPCS**  
Enter a partial spelling of the **HCPCS** code or description and click the drop-down arrow (or press the `<Tab>` key) to select a code containing the characters that you entered.

**CPT Modifier**  
Below the HCPCS field there are four radio buttons that correspond to the following CPT Modifiers:

- Left
- Right
- Both
- N/A

Click the applicable **CPT Modifier** radio button.

**Shortcut:**  
Press the `<Tab>` key to move focus to the CPT Modifier area, then use the arrow keys to select a CPT Modifier.

**Extended Description**  
To enter a longer description of the item, click the **Extended Desc.** button. The OWL Extended Description window shown below displays. You can type a free-text extended description of an unlimited maximum number of characters. Click the OK button to close the window.
<table>
<thead>
<tr>
<th><strong>Unit of Issue</strong></th>
<th>The Unit of Issue is 1 by default and cannot be changed.</th>
</tr>
</thead>
</table>

**Note:** Any field on this screen with a yellow background is for display only and cannot be modified.

<table>
<thead>
<tr>
<th><strong>Quantity</strong></th>
<th>The quantity defaults to 1 and cannot be changed.</th>
</tr>
</thead>
</table>
Changing the Date Required

**Change Date Required**

Today’s date defaults into the Date Required field. To select a different date, click the **Change Date Required** button.

**Note:** You may only select today’s date or a future date.

---

**Please select a new Date Required**

![Calendar](image)

*This selected Due Date is 30 days from today*
Changing the Print Location

Once you submit the lab work order, a request receipt will print automatically to the printer specified in the Print Location field.

To change the printer, click the Change Print Location button, located near the lower-left corner of the window.

The Please Select a Printer window displays.

You may select one of the following three printer types:

- A Window Printer
- A VistA Printer of your choice
- The Default VistA Printer

Note: The default VistA printer is defined in file 669.9 PROSTHETICS SITE PARAMETER.

Depending on the Lab Type you chose when the OWL was created, the VistA printer is defined in the following field:

- Optical - 26 - EYE CLINIC LAB DEVICE
- Orthotics/Prosthetics - 27 - ORTHOTIC LAB DEVICE
- Restoration - 28 - RESTORATION CLINIC DEVICE
- Wheelchair - 30 - WHEELCHAIR REPAIR SHOP DEVICE
Windows Printer

To select a Windows printer, click the **Windows Printer** button in the Change Print Location area. The Windows Print dialog displays.

Select the desired printer from the **Name** dropdown, then click **OK**.

---

**Windows Printer selection window**

![Windows Printer selection window](image)

---

Default VistA Printer

To print to the Default VistA Printer, click the **Default VistA Printer** button, then click **OK**.

**Notes:** The Default VistA Printer is the default print location, so you don’t have to do anything unless you’ve already changed the printer before. The default VistA printer is defined in file 669.9 PROSTHETICS SITE PARAMETER.

Depending on the Lab Type you chose when the OWL was created, the VistA printer is defined in the following field:

- Optical - 26 - EYE CLINIC LAB DEVICE
- Orthotics/Prosthetics - 27 - ORTHOTIC LAB DEVICE
- Restoration - 28 - RESTORATION CLINIC DEVICE
- Wheelchair - 30 - WHEELCHAIR REPAIR SHOP DEVICE

---

Choose a VistA Printer

To select a particular VistA Printer, choose a from the **VistA Printer** dropdown list, then click **OK**.
VistA Printer dropdown list

Selected Printer

After you click OK, the name of the selected printer displays in the Print Location field.
Viewing Additional Information

The lower-left corner of the Create Lab Work Order screen contains the following three buttons:

- 2319
- CPRS
- Request

These buttons, described briefly below, function just as they do on the Purchase Order Control window. For more information, see Section 1 of this manual.

**2319 button**

To view all eight tabs of 2319 data for a patient, click the 2319 button.

For more information, see Chapter 4 in Section 1 of this manual.

**CPRS button**

To view the CPRS record for a patient, click the CPRS button.

For more information, see Chapter 5 in Section 1 of this manual.

**Request button**

To view the request (if information is available for this patient), click the Request button.

For more information, see Chapter 6 of Section 1 of this manual.
Submitting the Lab Work Order

To submit the Lab Work Order, click the **Create Lab Work Order** button, in the lower-right corner of the Create Lab Work Order window.

The request receipt will print to the printer specified in the Print Location area.
Section 6
Orthotic Lab & Work Order

Overview

Accessing the Orthotics Work Order and Lab window

The OWL window is accessible from two different locations:

Method 1 – Accessing OWL from the Prosthetics Main Menu

At the Prosthetics Main Menu, click the Orthotic Lab & Work Order button. The OWL window displays.

Method 2 – Accessing OWL from the Purchase Control window

At the Purchase Order Control window, click the OWL button. The OWL window displays.
**Orthotics Work Order and Lab window**

**Quitting Work**  If you need to stop working at any point during the workflow, click the **Close** button in the lower-right corner of the window. You will return to the Main Menu.
Orthotic Lab & Work Order Window Areas

Seven Major window areas

The OWL window contains seven major areas where you can view information or enter data. These areas are described below.

- Title bar
- Menu bar
- Work Orders listview
- HCPCS area
- Command Buttons
- HCPCS Materials area
- HCPCS Labor area

Title Bar

The title bar runs along the top edge of the OWL window. Its default color is blue and it contains the name of the application.

The three buttons at the far right of the title bar allow you to minimize, maximize/restore, and close the window.
Menu Bar

The menu bar lies below the title bar. The OWL title bar contains eight options: File, Select & Display, View, Work Order, HCPCS, Materials, Labor, and Help. Click an option on the menu bar to list all the operations you can perform from within that menu. Click the desired option to execute a specific function.

Each menu option and its corresponding suboptions display as listed below:

File menu

The following options are available from the File menu:

- **Print OWL**: Print the selected lab work order.
- **Exit**: Save current data and close the OWL window.

Select & Display menu

The following options are available from the Select & Display menu:

- **Pending Assignment**: Toggle Pending Assignment box checked/unchecked. Check box to display lab work orders not assigned to a tech.
- **Assigned**: Toggle Assigned box checked/unchecked. Check box to display lab work orders assigned to a tech.
- **Completed**: Toggle Completed box checked/unchecked. Check box to display lab work orders with a Completed status.
- **Cancelled**: Toggle Cancelled box checked/unchecked. Check box to display lab work orders with a Cancelled status.
- **Display/Refresh**: Refresh the Work Orders Listview display.

For more information on using the Work Orders listview, see “Filtering the Work Orders Listview,” later in this chapter.

View menu

The following options are available from the View menu:

- **View 2319**: Display 2319 information for the selected lab work order.
- **View CPRS**: Display CPRS information for the selected lab work order.
- **View Request**: Display request information for the selected lab work order.
### Work Order menu
The following options are available from the Work Order menu:

- **OWL Detail**: Display lab work order detail.
- **Assign Tech**: Assign a technician to the selected lab work order.
- **Complete OWL**: Complete the selected work order.
- **Cancel OWL**: Cancel the selected work order.
- **Print OWL**: Display the Print Lab Work Order dialog.

### HCPCS menu
The following options are available from the HCPCS menu:

- **Detail / Edit**: Display OWL Material dialog.
- **Add HCPCS**: Add secondary HCPCS items.

### Materials menu
The following options are available from the Materials menu:

- **Detail / Edit**: View/edit the selected HCPCS materials.
- **Add Material**: Add secondary HCPCS materials.

### Labor menu
The following options are available from the Labor menu:

- **Detail / Edit**: View/edit the selected HCPCS labor.
- **Add Labor**: Add labor hours for HCPCS item.

### Help menu
The following options are available from the Help menu:

- **Contents**: Display this online Help file.
- **About**: Display Prosthetics VistA Suite version # and compilation date.
Work Orders Listview

Use this area of the screen to view, filter, and sort work orders. It contains four checkboxes, a command button, a sortable listview, and a display of the total number of work orders.

For more information, see the “Filtering Lab Work Orders” section on page 181 of this manual.
HCPCS Area

Overview

Use this area of the screen to add, edit, and delete HCPCS items. It contains a sortable listview and two buttons.

The total number of HCPCS items and the total cost of HCPCS for the selected work order display below the listview.

For more information, see the “Managing HCPCS Items” section on page 184 of this manual.

HCPCS Listview

The following list provides an overview of some of the main features of the HCPCS listview:

- The number following the **HCPCS for Work Order** label matches the Lab Work Order (LWO) Number of the row highlighted above in the Work Orders listview.
- The primary HCPCS item is indicated by a YES in the **Pri** column of the HCPCS listview. This HCPCS code matches the code selected when the work order was created.
- Click the **Detail/Edit** button to view or edit the item highlighted in the HCPCS listview. The OWL HCPCS window displays. You can edit all fields on the OWL HCPCS window except Qty, Unit of Issue, and Total Cost. (See Editing a HCPCS Item.)
- Click **Add HCPCS** to add secondary HCPCS items to the work order. (See “Adding a HCPCS Item.”)
Command Buttons Area

A command button is a large button which, when clicked, executes a command. The Command Buttons area contains the following eight buttons:

- OWL Detail
- 2319
- CPRS
- Request
- Assign Tech
- Complete OWL
- Cancel OWL
- Print OWL

Their functions are described in the Workflows section starting on page 181 of this manual. For more information, see the following sections:

- Managing Lab Technicians (page 182)
- Printing the OWL (page 193)
- Completing the OWL (page 194)
- Cancelling the OWL (page 195)
- Closing the OWL (page 196)

Click the OWL Detail button to display information about the work order currently highlighted in the Work Order listview.
The information on this screen is for display only and cannot be modified from this screen.
HCPCS Materials Area

**HCPCS Materials Area**

Use this area of the screen to add, edit, and delete materials related to HCPCS items. It contains a sortable listview and two buttons.

The total number of Material Entries and the total cost of materials for the selected HCPCS item display below the listview.

For more information, see the “HCPCS Materials” section on page 187 of this manual.

---

**HCPCS Labor Area**

**HCPCS Labor Area**

Use this area of the screen to add, edit, and delete labor related to HCPCS items. It contains a sortable listview and two buttons.

The total number of Labor Entries and the total cost of labor for the selected HCPCS item display below the listview.

For more information, see the section “HCPCS Labor.”
Filtering Lab Work Orders

Four checkboxes allow you to filter the Work Orders listview. The Pending Assignment and Assigned checkboxes are checked by default.

To filter the Work Orders listview, do the following:

1. Check the desired boxes:
   - **Pending Assignment**: Display work orders with a Status of PENDING ASSIGNMENT (i.e., work orders with no Assigned Tech).
   - **Assigned**: Display work orders with a Status of ASSIGNED TO TECHNICIAN.
   - **Completed**: Display work orders with a Status of COMPLETED.
   - **Cancelled**: Display work orders with a Status of CANCELLED.

   The four checkboxes work in various combinations. Checking more than one checkbox displays the selected results connected by the Boolean operator OR. For example, if you check the boxes Assigned and Cancelled, then click Display/Refresh, the listview displays work orders with a Status of ASSIGNED TO TECHNICIAN or CANCELLED.

2. Click **Display/Refresh**.

Notes: This listview only displays completed and cancelled work orders that were created in GUI OWL.

**Work orders created in roll & scroll will not display here.**
Managing Lab Technicians

Assigning a Tech

To assign a technician to a work order that is pending assignment, do the following:

1. Highlight a work order with a status of **Pending Assignment**, then click the **Assign Tech** command button. The Assign Technician window displays.

2. Type a few **characters** of the tech’s name, then press <Tab> or click the down arrow button to display names drop-down list. Select a **name**.

3. Click **Assign**. The Assign Technician window closes and the Work Orders listview displays the chosen tech’s name in the Assigned Tech column.

**Note:** Because the listview automatically refreshes after you click Assign, the Assigned box must be checked for you to see the work order with the newly-assigned tech. If the Assigned box is not checked, the work order disappears from the listview. To see it, check the **Assigned** box, then click **Display/Refresh**.
**Editing a Tech**  To change the technician on a work order that already has an assigned tech, do the following:

1. Highlight the work order with an Assigned Tech, then click the **Assign Tech** command button. A popup window displays the following confirmation message: “This Work Order has already been assigned. Do you wish to change the assignment?”
2. Click **Yes** to close the popup. The Assign Technician window displays.

![Assign Technician Window]

3. Type a few **characters** of the tech’s name, then press **<Tab>** or click the down arrow button to display names drop-down list. Select a new **name** from the drop-down list.
4. Click **Assign**. The Assign Technician window closes and the Work Orders listview displays the chosen tech’s name in the Assigned Tech column.
Managing HCPCS Items
Adding a HCPCS Item

To add a secondary HCPCS item, do the following:

1. Click the Add HCPCS button to add an additional HCPCS item. The OWL HCPCS Add On Item window displays.

![Add On Item window]

2. Type a few characters in the Billing Item dropdown list, then press <Tab> to select a Billing Item from the dropdown list.
3. Type a few characters in the HCPCS dropdown list, then press <Tab> to select a HCPCS code.
4. Optionally check the Hi-Tech Item checkbox.

Note: Hi-Tech items are HCPCS that are flagged by the user to be using high technology. The list of Hi-Tech items is provided by VACO and DVG. To obtain the latest list of approved Hi-Tech items, contact the Prosthetics and Clinical Logistics Office (10FP).

5. Select the appropriate CPT Modifier radio button. This is required.
6. Optionally enter a brief description in the Brief Desc field.
7. The Qty field defaults to 1 and cannot be modified.
8. The Unit of Issue defaults to EA (each) and cannot be edited.
9. The Total cost defaults and cannot be edited.
10. Optionally enter a Serial Number.
11. Optionally type or paste text into the Extended Description field.
12. Click the Quit button to close the Add On Item window without saving changes, or click Add. After you click Add, the Add On Item window closes and the HCPCS item is added to the HCPCS listview.
To edit a HCPCS item, do the following:

1. Highlight the row of the HCPCS item to be edited, then click **Detail/Edit**. The OWL HCPCS window displays.

![OWL HCPCS window](image)

2. You can edit the data in all fields except for the following three:
   - Qty
   - Unit of Issue
   - Total Cost

3. To finish the workflow, click one of the following buttons:
   - Click **Update** to save all changes and close the OWL HCPCS window.
   - Click **Quit** to discard changes and close the OWL HCPCS window.
   - Click **Delete** to remove this HCPCS item from the work order.

**Note:** The **Delete** button is disabled for the Primary HCPCS item, which can be edited but not deleted.
Deleting a HCPCS Item

To delete a HCPCS item from the work order, do the following:

1. Highlight the HCPCS item in the HCPCS listview on the OWL window, then click **Detail/Edit**. The Add On Item window displays.

   **Note:** The Delete button is disabled for Primary HCPCS items. You may only delete Add-On HCPCS items this way.

2. Click **Delete**. A popup window asked you to confirm the deletion.
3. Click **Yes**. The HCPCS item is removed from the HCPCS listview.
HCPCS Materials

Adding Materials for a HCPCS Item

To add materials for a HCPCS item, do the following:

1. Highlight an item in the HCPCS listview.
2. Click the Add Material button. The OWL Material window displays.

3. Type a few letters in the Material field, then press <Tab> and select a material from the drop-down list. Examples: Velcro, plaster, rivets, leather.

   Note: The material must be loaded in the local item file or it won’t display in the drop-down list.

4. Enter a quantity in the Qty field.
5. Specify a Unit of Issue.
6. Enter a Cost.
7. Optionally enter a Serial Number.
8. Optionally select a Vendor.
10. Click Add. The OWL Materials window closes and the material is added to the Materials listview. Any cost is added to the Cost field.
To edit materials for a HCPCS item, do the following:

1. Highlight a row in the Materials listview, then click **Detail/Edit**. The OWL Material window displays.

2. You can edit the data in any field on this window.
3. To finish the workflow, click one of the following buttons:
   4. Click **Update** to save all changes and close the OWL Material window.
   5. Click **Quit** to discard changes and return to the OWL window.
   6. Click **Delete** to remove this material from the HCPCS item.
Deleting Materials for a HCPCS Item

To delete material from a HCPCS item, do the following:

1. Highlight a row in the Materials listview, then click **Detail/Edit**. The OWL Material window displays.

2. Click **Delete**. A confirmation pop-up window displays.

3. Click **Yes** to delete the material. The OWL Material window closes and the material is removed from the listview.
**HCPCS Labor**

Adding labor To add labor costs to a HCPCS item, do the following:

1. Highlight an item from the HCPCS listview, then click **Add Labor**. The OWL Labor window displays.

   ![OWL Labor Window]

2. Type the first few letters of a tech’s last name, press `<Tab>`, then select a technician from the drop-down list.

   **Note:** If only one tech name matches the letters you entered, that name is selected as soon as you press `<Tab>`, and your cursor focus moves to the Date field.

3. Optionally change the **Date**.
4. Enter the number of **Hours**.
5. Enter the hourly **Rate**.
6. Click **Add**. The labor displays in the Labor for HCPCS listview and the labor cost is added to the Cost field.
Editing Labor  
To edit labor costs for a HCPCS item, do the following:

1. Highlight a row in the Labor listview, then click **Detail/Edit**. The OWL Labor window displays.

   ![OWL Labor Window](image)

   - **Technician:** BUSTAMANTE, ALFRED
   - **Date:** 8/14/2006
   - **Hours:** 3
   - **Rate:** $12.00

   **Update** | **Delete** | **Quit**

2. Edit the information as desired.

   **Note:** Once a technician has been added, you cannot change the tech the next time you return to edit HCPCS labor. To change the technician on HCPCS labor, you must delete the labor and add it back with the correct tech.

3. Click **Update**. The OWL Labor window closes and changes are saved.
Deleting Labor  To delete labor costs for a HCPCS item, do the following:

1. Highlight a row in the Labor listview, then click *Detail/Edit*. The OWL Labor window displays.

2. Click *Delete*. A confirmation pop-up window displays.
3. Click *Yes* to delete the labor. The OWL Labor window closes and the labor is removed from the listview.
Printing the OWL

To print a lab work order, do the following:

1. Highlight the desired lab work order in the Work Orders listview.
2. Click the Print OWL button. The OWL Print Lab Work Order window displays.

3. The OWL will print on the printer listed in the Current Print Location field. To print to the default printer, skip to step 5. To change printers, continue with step 4.
4. This window provides three printer options:
   - To select a Windows Printer, click the Windows Printer button. Select a printer from the Name drop-down list, then click OK. Proceed to step 5.
   - To select a VistA Printer other than the default, select a printer from the VistA Printer drop-down list. Proceed to step 5.
   - To select the default VistA Printer, click the Default VistA Printer button. Proceed to step 5.

Note: The default VistA printer is defined in file 669.9 PROSTHETICS SITE PARAMETER. Depending on the Lab Type you chose when the OWL was created, the VistA printer is defined in the following field:
   - Optical - 26 - EYE CLINIC LAB DEVICE
   - Orthotics/Prosthetics - 27 - ORTHOTIC LAB DEVICE
   - Restoration - 28 - RESTORATION CLINIC DEVICE
   - Wheelchair - 30 - WHEELCHAIR REPAIR SHOP DEVICE

5. Click Print Lab Work Order. The work order prints and the OWL Print Lab Work Order window closes.
Completing the OWL

To complete the OWL, do the following:

1. Highlight the desired **lab work order** in the Work Orders listview.
2. Click the **Complete OWL** button. The OWL Complete window displays. This window displays the lab work order number, patient name, and patient SSN. It also informs you of the following three things:

   - You are about to COMPLETE this work order.
   - You are about to CLOSE the original consult.
   - This will prevent any further OWL activities or purchasing for this work order.

3. Optionally enter text in the **Post note to CPRS** field.
4. Click the **Complete** button to complete the work order and close the original consult. A Confirm window displays.
5. Click **Yes** to complete this work order. A Prosthetics VistA Suite window pops up to display the following information:

   - Completed Suspense Action.
   - Posted note to CPRS Consult.
   - Suspense status has been updated to CLOSED.

6. Click **OK** to close the Prosthetics VistA Suite window.
Cancelling the OWL

To cancel an OWL lab work order, do the following:

1. Highlight the desired lab work order in the Work Orders listview.
2. Click the Cancel OWL button. The OWL Cancel window displays. (See image at the top of the next page.) This window displays the lab work order number, patient name, and patient SSN. It also informs you of the following three things:
   - You are about to CANCEL this work order.
   - You are about to CLOSE the original consult.
   - This will prevent any further OWL activities or purchasing for this work order.
3. Optionally enter text in the Please enter a CPRS note about this cancellation field (such as a reason for the cancellation).
4. To create a clone of this consult, check the box following the question Do you wish to create a CLONE of this consult for future use? Note: You may wish to clone a consult in the event that you need to make another purchase on the closed consult.
5. Click the Cancel Work Order button. A confirmation window pops up to display the question Are you sure you wish to CANCEL this Work Order?
6. Click Yes to cancel the work order. A Prosthetics VistA Suite window pops up to display the following information:
   - Complete Suspense Action.
   - Posted note to CPRS Consult.
   - Suspense status has been updated to CANCELLED.
7. Click OK to close the Prosthetics VistA Suite window.
Closing the OWL

To exit the OWL window, click the Close button in the lower-right corner of the window. The OWL window closes and you return to the Prosthetics Main Menu.
Appendix A

Getting Help

F1 Key

Online Help can be accessed in three methods:

1. Click the Help Menu (located in the upper left corner of the menu bar) and the Contents option.
2. Press the <F1> key.
3. Press the <Alt> key + <H> key. (This activates the Help Menu, not the Billing contents.)

Help Menu

![Image of Help Menu]

Please enter a range of dates to View Prosthetic Billing Information

- Beginning Date: Feb 01, 2004
- Ending Date: Apr 30, 2004

Options to display:
- Display
- Print
- Excel

Insurance Information:
- Insurance ID
- Sub ID
- Group
- Effective
- Expires

Disability Information:
- Disability
- %
- BC

Records Found: 2
Appendix B

Using the Menus

Menus

Below are the different menus and menu options that are available to be used instead of the corresponding buttons. You can use these menu options alternatively.

The Help Menu is the only menu that does not have a corresponding button. This menu leads you to online help through the Contents option. The Section 508 option is described more in Appendix B.
Appendix C

Activate Section 508 Assistance

Introduction
You can change the colors of the screen to black/white, which is required for Section 508 requirements to be read by visually and hearing impaired veterans.

This feature can be updated from the Help Menu. It provides a toggle to go back and forth between using the colors or the black/white screens depending on your needs.

Steps
To activate the Section 508 assistance, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Help Menu, and click the Section 508 option.</td>
</tr>
<tr>
<td>2</td>
<td>Click OK on the confirmation message dialog box as shown below.</td>
</tr>
<tr>
<td>3</td>
<td>Click OK again to exit out of the system and restart to activate the changes.</td>
</tr>
</tbody>
</table>

Confirmation message

Do you wish to activate Section 508 assistance?

Yes  No